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ABSTRACT

PLANNING of ELECTRICITY DISTRIBUTION SYSTEMS
BASED on
GEOGRAPHICAL INFORMATION SYSTEMS (GIS)

VELIOGLU, Ali
M.Sc. in Industrial Engineering
Supervisor: Assist. Prof. Dr. Faruk GEYiK
January 2005, 100 pages

This thesis represents a GIS (Geographic Information System) application in
planning of electricity distribution systems. Problems in the planning and operating
stages of the electricity distribution network are investigated and analyzed. The
electricity distribution network is considered to integrate with GIS technology. The
electricity distribution network model for the city is established with GIS and GPS
(Global Positioning System) support. The digital map of the electricity distribution
network is produced by MapInfo® and then end-user software tools are developed by
using MapBasic® software’s. To facilitate an electrical analysis, calculation tools
(Voltage Drop Analysis - Power Loss Analysis), printing and a lot of reporting tools
(find-subscriber, find-transformer, etc.) are developed. By the application, the current
electricity distribution network of Gaziantep is transferred to a digital environment
and it is used for the planning and operating of the network. In this study, each stage

of the application is explained and shown with examples.

Keywords: Electricity Distribution Systems, Electricity Distribution Planning,
GIS (Geographic Information Systems)
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ELEKTRIK DAGITIM SISTEMLERININ
COGRAFI BiLGI SISTEMLERI (CBS) TABANLI
PLANLAMASI

VELIOGLU, Ali
Yiiksek Lisans Tezi, Endiistri Miihendisligi Boliimii
Tez Yoneticisi: Yrd. Dog. Dr. Faruk GEYIK
Ocak 2005, 100 sayfa

Bu tez, elektrik dagitim sistemlerinin planlamasinda CBS (Cografi Bilgi Sistemleri)
tabanli bir uygulamay1 gostermektedir. Elektrik dagitim sebekesinin planlama ve
isletme asamalarinda karsilagilan problemler incelenmis ve analiz edilmigtir. Elektrik
dagitim sebekesinin CBS teknolojisiyle entegre edilmesi diisiiniilmiistiir. CBS ve
KKS (Kiiresel Konumlama Sistemi) destegiyle sehir i¢in elektrik dagitim sebeke
modeli kurulmugtur. Elektrik dagitim sebekesinin MapInfo® ile sayisal haritas
tiretilmis ve sonra MapBasic® ile son kullamciya yonelik araglar gelistirilmigtir.
Elektriksel analizi kolaylagtirmak igin, hesaplama araglari (Gerilim Diiglimii Analizi-
Giig Kayb1 Analizi), ¢ikt1 ve birgok raporlama araci (abone-bul, trafo-bul vb.)
geligtirilmistir. Bu uygulama ile Gaziantep’in mevcut elektrik dagitim sebekesi
sayisal ortama aktarilarak, sebekenin planlama ve igletmesinde faydalamlmigtir. Bu
¢alismada, uygulamamn her safhasi agiklanmig ve 6rnekleriyle gosterilmistir.

Anahtar Kelimeler: Elektrik Dagitim Sistemleri, Elektrik Dagitim Planlamasi,
CBS (Cografi Bilgi Sistemleri)
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CHAPTERI1

INTRODUCTION

1.1. Introduction

There is a trend, which has been dominant over last 50 years on electrical distribution
systems planning: the movement of the population from villages to metropolitan
areas. The number of families in rural areas has continuously declined during this
century, this population flow into larger urban areas [1]. So the migration from the
suburbs to the urban and near-urban areas caused a vitally important problem for
electricity distribution system planners. Rapid developing cities and their energy
needs have gradually made electricity distribution systems as more complicated
structures. While such a complicated structure is managed, it is important that service
quality giving to the consumers is increased, that the current systems are more

effectively used, and that very appropriate decisions are made [2].

Because of unforeseen rapid increase in population of our country, some
infrastructural problems in urbanization appear. One of those problems is planning of
electricity distribution. Mostly electrical distribution systems are overlapped but not
synchronized and not even regularly updated. The major problem is lack of data: the
quantity, quality and accuracy of data. Therefore, distribution network cannot be
used optimally because electrical calculations such as voltage drop, power loss
cannot be done. In some districts while transformers may break down due to an
overloading, in some districts transformers are set up where they could be sufficient
even for the next ten years. This situation causes source extravagance for an
electricity distribution company and poor-qualified service for the consumers [3]. As
there are difficulties mentioned above, the observation of the network becomes more

complex and necessary statistical data cannot be gathered.

This chapter briefly introduces the electricity distribution problem and the electricity
distribution network of Gaziantep. And the aim of thesis is explained.



1.2. Electricity Distribution

Large amounts of power are generated at power plants and sent to a network of high-
voltage (380, 154 kV) transmission lines. These transmission lines supply power to
medium voltage (e.g. 30 or 15 kV) distribution networks (distribution primary
system), which supply power to still lower voltage (0.4 kV) distribution networks
(distribution secondary system). Both distribution network lines supply power to
customers directly. Thus, the total network is a complex grid of interconnected lines.
This network has the function of transmitting power from the points of generation to

the points of consumption.

An electric power distribution system delivers power to the customers via a set of
distribution substations. While transmission and subtransmission lines are configured
in a meshed network, distribution feeders are configured radially in almost all cases.
This radial configuration simplifies overcurrent protection of the feeder. To help
restore power to customers following a fault, most feeders are provided with tie
circuits to neighboring feeders from either the same or the different substations. A
number of switching operations are needed to restore power using these ties. Loads
vary with time of day, day of the week, and season. Each type of load (residential,
commercial, industrial) has a different time profile, and each feeder serves a different
mix of loads [4]. Therefore, the load pattern on each feeder varies constantly and
with a different variation on each feeder. This creates an opportunity that loses be

constantly keep at a minimum level by reconfiguring the feeders during the day.

1.3. Electricity Distribution Planning

Distribution system planning starts at the customer level. The demand type, load
factor and other customer load characteristics dictate the type of distribution system
required. Distribution system planners must determine the load magnitude and its
geographic location. A distribution substation must be placed and sized in such a
way as to serve the load at maximum cost effectiveness by both minimizing feeder

losses and construction costs, while considering the constraints of service reliability.

When feeders are newly expanded in a distribution system, allocation of new feeders,

new routes that connect from the new feeders to substations and tie-line routes to



other feeders, must be determined so as to minimize installation costs of new
facilities under such constraints as load-balancing, current capacity, voltage drop and
geographical installation restrictions [5]. However, it is difficult for planners to find
the optimal feeder expansion plan among various candidates. The problem of the
expansion planning has been how to minimize a new facility installation cost under
the constraints: 1) line and transformer capacity, 2) voltage drop at each load point,
3) demand/supply balance, and 4) radial configuration of the system. When an
expansion of power distribution feeders is planned in urban areas, the following
items must be taken into account: 1) geographical installation restriction, 2) feeder
load balance, 3) availability of interconnection between new feeders and existing
feeders in order to obtain reliability of power supply, 4) constraints of current
capacity, voltage drop and radial system structure, and 5) minimization of new
facility installation cost. It is difficult to find a space to install a new feeder in urban
areas because existing feeders are so dense. Furthermore, tie lines that connect the
expanded new feeder to the existing feeders must be newly installed to ascertain the

reliability of the power supply in a fault [5].

Design process of electricity distribution network can be divided into three
independent parts. These parts are load forecasting, design of secondary and primary
substations. Load forecasting means load growth of a geographical area served by
substation. Load growth is very much depended on the community and its
development. It is important to determine load magnitude, its geographic location
and customer load characteristics. Economic indicators, demographic data and
official land use plans all serve as raw input to the forecast procedure. The forecasted
load, load density and load growth may require a substation expansion or a new
substation construction [1]. In the system expansion plan the present system
configuration, capacity and forecasted loads can play major roles. The distance from
the load centers and from the existing subtransmission lines as well as other
limitations, such as availability of land, its cost and land use regulations are vitally
important. There are some factors, which influence the load forecast, such as

geographical factors, city plans, industrial plans, load density, population growth.

Design of secondary system (low voltage distribution network) consists of optimal

substation allocation, transformer sizing, and secondary circuitry routing and sizing,.



Design of primary system (medium voltage distribution network) also consists of
optimal substation allocation, and primary circuitry routing and sizing.

Once the loads are assigned to the substations are determined, then the remaining
factors affecting primary voltage selection, feeder route selection, numbers of
feeders, conductor size selection, and total cost (the cost of equipment + labor and
money) need to be considered. The distribution system is particularly important to an
electrical utility for two reasons: its proximity to the ultimate customer and its high
investment cost [1, 6]. The objective of distribution system planning is to ensure that
the growing demand for electricity, with growing rates and high load densities, can
be satisfied in an optimum way, mainly to achieve minimum of total cost of the

distribution system expansion.

1.4. Electricity Distribution Network in Gaziantep

Gaziantep is the sixth largest city in the TURKEY with more than one million
inhabitants. After the formation of the Republic, electricity was provided to 105
settlements between 1923 and 1933, and the electricity consumption per person was
10 Kw/h in 1923. Gaziantep was among the first cities receiving electricity and an
Italian company built the first power station in 1932. Electricity was generated at this
station by using wood and coal at first and diesel fuel later. It was used to provide
lighting for homes and businesses first and later to industries. Electricity network of
Gaziantep was laid out by this Italian company in the 1930s and then between 1970
and 1975 it was partially improved and distributed by the Provinces Bank. Although
the power cable network was renovated after 1990 and was added on to with
delegation and deposit systems using a new master plan for the city, it was not

enough for the fast growing city.

The amount of increase in electric consumption was about 1139 million Kw/h
between 1995 and 2000. Nowadays, the average monthly energy sold in Gaziantep is
320 million kWh. A small amount is provided by 4 auto-producer power stations in
57.5 MVA installed capacity in Gaziantep Organized Industrial Zone for the purpose
of meeting the energy needs of their own plants and partners. Of the energy that is

sold in Gaziantep 65% goes to industry, 17% to dwellings, 6% to commercial



buildings, 5% to official buildings and 7% to other customers. There are currently a
total of 390,000 electricity customers and of these customers 81% are dwellings,

13% commercial and offices, 3% factories and 3% others.

In Gaziantep there are; Gaziantep I TM: 154/31.5 kV, 2x50 MV A, Gaziantep II TM:
154/31.5 kV, 2x100 MVA; 380/31.5 kV, 1x100 MVA, Gaziantep III TM: 154/31.5
kV, 2x100 MVA, Gaziantep IV TM: 154/31.5 kV, 1x50 MVA, 1x100 MVA.
Islahiye and Nurdag: townships’ energy received 2x25 MVA Fevzipaga TM, Araban
township center and villages with Yavuzeli township village’s energy received 1x50
MVA PS5 and 1x5 MVA PS4B TM; in Nizip and Karkanmms townships, energy is
received in 4 feeders 2x50 MVA from Birecik TM. There are about 7000 distribution
transformers (30(15)/0.4 kV) including those owned individually for miscellaneous
power and potential with 1.380 MVA installed capacity and 500 MW transferred

power.

Gaziantep electricity network consists of 5 secondary substations 30/15 kV, and
more then 5200 km of cables and overhead (aerial) lines. The electric utility TEDAS
GAZIANTEP as a part of the national power company TEDAS is responsible for
distribution of electric energy at medium and low voltage level, covering the urban
area and seven townships of Gaziantep. TEDAS GAZIANTEP serves more then
390,000 customers spreading over the area of about 6216 sq. km. Eventually, as

mentioned above the electricity network of Gaziantep is a quite large one.

1.5. Aim of the Thesis

Aim of the thesis is to present an application of electricity distribution planning
based on GIS for Gaziantep. This application is proposed to use as a decision support

system in management of electricity distribution network.

Gaziantep is a rapidly growing city, receiving intensive migration from the rural
settlements of the area. In recent years, this growth has assumed the form of
uncontrolled expansion, which is not supported by adequate urban planning work. It
has been become almost impossible to obtain information from electricity network of

the city and appreciation information to consider correctly about the problems. One



of the important problems was used to be getting the correct data while doing the
technical calculations in the electricity distribution planning. Since the information
on current maps is constantly changing, the maps need to modified or completely
redrawn to keep current situation. This is a very expensive and labor-time consuming
process. In addition, one department may produce a given map and another
department may use it, but whose latest version of the map may no longer be up-to-
date. This can lead to costly errors and lost time for all involved. It was possible to
do various mathematical calculations by appreciating conductor type and transformer
power sizing, but this would not be realistic. Because in planning of electricity
distribution for a city, it must be considered some factors such as the population, the
widen direction of the settlement places, the existing situation of trading and
industry, and the widen direction of the city. The load growth of the geographical
area served by a utility company is the most important factor influencing the
expansion of the distribution system. Hence, the thesis aims to integrate GIS into

electricity distribution planning for Gaziantep.

For this purpose, the model of electricity distribution network will be established for
Gaziantep with GIS and GPS support by using MapInfo®. In the current system,
calculations are not so reliable. To facilitate some electrical analysis such as voltage
drop, power loss and reporting, etc. some end-user software tools will be developed
by using MapBasic® on the GIS system. Thanks to those modules time consuming
calculations take as less time as seconds. Now, expansion scenarios for the new
additions to the distribution network can be developed in less time and better

decisions can be made for planning.

Briefly, an application will be developed, which is a modern information system and
a tool that manages everyday tasks related to operating, maintaining, planning,

design and actual expansion of the city’s electricity network.
1.6. Organization of the Thesis
In the first chapter, we introduce to electricity distribution problem. In this chapter,

importance of the problem for especially our country is mentioned. Chapter II

contains literature survey about the role of GIS in electricity distribution planning.



Chapter III explores GIS technology. In this chapter, it is mentioned that what GIS
can do, how it work and what its components is. Chapter IV step-by-step presents the
application of electricity distribution planning based on GIS for Gaziantep. Some

conclusions, discussion and future work is presented in the last chapter.



CHAPTER IT

LITERATURE SURVEY

2.1. Introduction

In this chapter a survey is done from literature related to role of GIS in electricity
distribution planning. We also survey about real GIS applications in electricity
distribution planning. However, we could not found any real applications in our

country which is also limited in the literature.

2.2. Electricity Distribution Planning

The other problem of distribution system planning is to find the optimum location of
the substation, the optimum feeder configuration to connect the loads to the
substation and the optimum branch conductor sizes. Many approaches to solve
optimally the distribution system planning have been proposed [7-13]. These
approaches are based on mathematical programming techniques such as branch and
bound technique and mixed integer programming method. Other some approaches to
solve heuristically the problem have been proposed [14-16]. These approaches are
based on artificial intelligence, especially expert systems. On the other hand, better
heuristic approaches have been proposed by some researchers [17-19]. These
approaches are based on load flow algorithm. Especially, the heuristic approach
proposed by [18] does not require prior knowledge of candidate substation location
and can automatically select location of a substation, the optimal feeder
configuration and the optimal sizes of branch conductors while satisfying constraints

such as current capacity, voltage drop and heuristic rules.

In those former studies mostly, small, simplified problems had been taken into
account. But optimization of electricity distribution system planning could not be
integrated with GIS. But in real an electricity distribution system contains many

geographical restrictions. For distribution systems planning or feeder expansion in



the urban area it is very difficult to find the space for substation and feeder. In
addition to this, finding the optimal candidate location itself will not suffice to solve
the problem, heuristic rules need to be incorporated for a feasible optimal distribution
system planning. Solving the exact problem by using classical optimization

technique is not possible because of the combinatorial nature of the problem.

2.3. Role of GIS in Electricity Distribution Planning

In order to control dynamically changing structure of residences a dynamical
planning is required. GIS is the most suitable tool for collecting the data needed for
electrical distribution plans in a short and actual way. GIS can prevent the
inefficiency and extension of voltage drop limits as a system which can update the
current electrical distribution maps and monitor the whole network [20]. GIS can not
only supply a digital map but because it can built up a relational database whenever
there exists a click on the map complete data belonging to that point is called and
presented to the user and analysis can be made coinciding with the purpose. This
property of GIS made the calculation of electrical data and preparation of reports
possible and made it vital for the planning of electrical distribution [2]. Most of the
electrical network/equipment has a geographical location and the full benefit of any
network improvement can be had only if the work is carried out in the geographical
context. Business processes such as network planning, repair operations and
maintenance connection and reconnection has also to be based around the network
model. Even while doing something as relatively simple as adding a new service
connection; it is vital to know that users of the system are not affected by this
addition. GIS in conjunction with system analysis tools helps to do just this [21].

Electric utilities have a need to keep a comprehensive and accurate inventory of their
physical assets, both as a part of normal service provision (extending the network,
undertaking maintenance, etc.) and as a part of their obligation to inform third parties
about their facilities. The complexity of an electrical distribution power system is a
good reason for introducing new information technology -GIS- that carries out
complex power system analyses (e.g., fault analysis, optimization of networks, load
forecasting) in acceptable amount of time. By using modern GIS, in conjunction with

its own in-house developed software, in less time and more accurately, the utility



engineer is able to design and to analyze electrical distribution network. The
distinguishes an electrical utility information system from an other information
system - such as those used in banking, stock control, or payroll systems - is needed
to record geographical information in the database. Electrical utility companies need
two types of geographical information: details on the location of facilities, and
information on the spatial interrelations between them. The integration of
geographically referenced database, analytical tools and in-house developed software
tools will allow the system to be designed more economically and to be operated
much closer to its limits resulting in more efficient, low-cost power distribution

systems [6, 22].

The planning and the design of the electrical supply system are daily tasks for
engineers in the electric utilities. The goal of power distribution system planning is to
satisfy the growing and changing system load demand during the planning period
within operational constraints and with minimal costs. The planning process
comprises several phases, and one of the most important is the optimization of the
electric distribution network. The network optimization is considered a hard
combinatorial optimization problem due to a number of limitations (network voltage
level, network structure, amounts and locations of loads, routes and types of feeders,
voltage drops, etc.). An additional complexity is imposed by the geographically
referenced data. In this process it is important to have on time accurate relevant
(related) data and information on the electric distribution system and its assets, and
possibly to have data from other utilities. Computerization and development of
various geographic information systems have opened new horizons for all decision-

making processes as well as for manipulation and dissemination of information [23].

For efficient and reliable operation of a distribution system, a reliable and well knit
communication network is required to facilitate project coordination of the
maintenance and fault activities of the distribution system. GIS when integrated with
real time SCADA (Supervisory Control and Data Acquisition) can help in sending
the right signals to the communication network. GIS environment hosts a wealth of
presentation techniques that enable fast and accurate interpretation of results from

power flow results to short circuit analysis [21].
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GIS database provides the source of sufficiently accurate data on medium-voltage
distribution network assets. Its spatial data model comprises topological information
on network elements (connectivity, sharing, adjacency, proximity, overlapping, etc.),
providing the foundation for spatial analyses and reasoning. The accurate positions
and lengths of the existing cables and all their segments in the cable route between
two substations are defined. The exact locations of existing and proposed locations of
future-planned substations, as a result of load growth analyses and predictions, are
known. The possible routes for new cables in keeping with urban zoning plans,
ecological and aesthetic constraints are also known from database spatial queries and
graphic presentation of observed geographic area. The knowledge of precise cable
lengths (i.e. segments of the cables between substations) and other corresponding
attributes (e.g. the year the cable segment was laid down, construction type, material,
cross section, operating voltage) for the existing cables and selected set of possible
new cable routes enables the better electrical analyses and planning of the network.
GIS mechanisms of spatial and non-spatial querying enable us to reach the relevant
data and information for the process of optimization and planning the distribution
network. The same mechanisms are applied to analyses of interim or final planning
results. The GIS is also used as graphical editor for displaying and taking interactive
actions during the whole planning procedure. Layers of information are contained in
map representations. For example; the first layer corresponds to the distribution
network coverage. The second layer corresponds to the land background containing
roads, landmarks, buildings, rivers, railway crossings etc. The next layer could

contain information on the equipment poles, conductors, transformers etc.[21, 23].

GIS, as its basic feature, provides to the users precise geographical location of an
object. This feature of GIS is definitely useful to the electrical utilities. The objects
for electrical utilities are their assets in the form of equipment and supply cables that
are installed in the field. Therefore, the utility would greatly benefit if it could locate
its assets precisely and also get as much information about them as possible by using
the GIS technology [24]. GIS, to yield this important benefit, would normally require
that, the utility should place its assets correctly on the accuratc and reliable
geographical maps of its service area. To process the information associated these

assets correctly, and prepare required reports, it is necessary that the utility includes,
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as much information as possible, in the form of attributes of the objects that are

placed on the maps.

In the era of restructuring and modernization of electric utilities, the application of
GIS technology in the power industry is growing and covering several technical and
management activities. The integration of GIS with existing power analysis tools is
tremendously improving planning and operation of the system. As modern
technologies arise, power utilities are seeking new methods to improve system
reliability, power quality and customer satisfaction [25]. High quality of the power
can only be achieved if the system losses are at their minimum level and the voltage

level is within an acceptable range.

GIS provide a real solution to the management of the data required for engineering
analyses. In addition, it provides tools to support the planning of spatial components
and means to interface to third party analysis tools [25]. Most GIS electric power
studies and analysis applications were developed for electrical distribution systems
analysis and design. GIS was used as a component of a full-featured distribution
automation system [26]. Other applications tackled the problem of designing the
electrical supply system for new residential development [27]. Other utilities have
been also investing on process automation in order to provide their customers with
high quality attendance [28-31]. GIS was also used to rebuild the design of the whole
work procedures in electric utilities [32]. GIS and GPS are also integrated for

mapping and analysis of electric distribution circuits [33].

GIS integrate common database operations such as query and statistical analysis with
the unique visualization and geographic analysis benefits offered by maps. These
abilities distinguish GIS from other information systems and make it valuable from
explaining events, predicting outcomes and planning strategies for distribution
system management. Nowadays not making so much projects regarding city planning
brings huge economical losses along with. In order to stop the occurrence of those
losses, long term designs must be made and information technology must be used.
GIS brings those facilities to the users. GIS is an important tool in this area. In brief,
GIS is necessary for making optimum decisions in planning, engineering and a

healthy flow of administrative data for analysis of electrical distribution plans.
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CHAPTER 11

GEOGRAPHIC INFORMATION SYSTEM (GIS)
3.1. Introduction

At the beginning of the chapter, definitions of GIS are given. At the following
sections GIS’s capabilities, working methods, components, advantages and some

application areas are given.

3.2. Definitions

GIS is a special-purpose digital database in which a common spatial coordinate
system is the primary means of reference. A comprehensive GIS require

1. Data input, from maps, aerial photos, satellites, surveys and other sources

2. Data storage, retrieval and query

3. Data transformation, analysis and modeling, including spatial statistics

4. Data reporting, such as maps, reports and plans

There are observations about this definition:

First, GIS is related to other database applications, but with an important difference.
A GIS database uses geo-references as the primary means of storing and accessing
information. Second, GIS integrates technology. Whereas other technologies might
be used only to analyze aerial photographs and satellite images, to create statistical
models, or to draft maps, these capabilities are all offered together within a
comprehensive GIS. Third, GIS, with its array of functions, should be viewed as a
process rather than as merely software or hardware. GIS are for making decisions.
The way in which data is entered, stored, and analyzed within a GIS must mirror the
way information will be used for a specific research or decision-making task. To see
GIS as merely a software or hardware system is to miss the crucial role it can play in

a comprehensive decision-making process [34].
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Geographic information is a significant subset of the information explosion that has
occurred over the last two decades. In the broadest sense, geographic information is
information that includes an ocational/spatial reference (street address,
latitude/longitude, section/township) as part of the data records. The geographic
component of information has become increasingly important as information
technologies, such as GIS, have been developed to analyze and display information
based on its location [35]. GIS is computer-based software that integrates the maps
(spatial/graphical component) and database (tabular alphanumeric component)
aspects of information. A GIS is designed for the collection, storage and analysis of
phenomena where geographic location is an important characteristic or critical to the

analysis.

A GIS is core information technology with capabilities to effectively collect,
organize, access, and analyze geographic information. In its simplest form, GIS
technology supports automated mapping the creation, update, and production of
maps providing great advantages over manual mapping methods. But GIS is much
more than a mapping tool. GIS software has the ability to store graphic
representations of map features and to access diverse types of data and records that
are geographically referenced [36]. It allows users to access, examine, and analyze

geographically referenced information.

A GIS is a facility for preparing, presenting, and interpreting facts that pertain to the
surface of the earth. This is a broad definition . . . a considerably narrower definition,
however, is more often employed. In common, a GIS is a configuration of computer
hardware and software specifically designed for the acquisition, maintenance, and

use of cartographic data.[37].

A GIS is an information system that is designed to work with data referenced by
spatial or geographic coordinates. In other words, a GIS is both a database system
with specific capabilities for spatially-reference data, as well [as] a set of operations
for working with data . . . In a sense, a GIS may be thought of as a higher-order map
[38].
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A GIS is an organized collection of computer hardware, software, geographic data,
and personnel designed to efficiently capture, store, update, manipulate, analyze, and

display all forms of geographically referenced information [39].

A GIS is a computer system capable of assembling, storing, manipulating, and
displaying geographically referenced information, i.e. data identified according to
their locations. Practitioners also regard the total GIS as including operating
personnel and the data that go into the system. These definitions tell that GIS means
different things for different groups of people. Different definitions of GIS
emphasize different aspects of GIS. There are also arguments about what GIS should
be called. In the United States, it's called geographic information systems; whereas in
the United Kingdom and Europe it's called geographical information systems. In
Canada, it's called geomatics [40].

3.3. What Can GIS Do?

GIS allows users to view, update, query, analyze, combine, and manipulate map data.
It can take information from different map and tabular sources and register them to a
desired base. It can manage large collections of natural resource and environmental
data and the complex data sets needed for urban studies. It can overlay maps to
eliminate or include areas based on multiple layers of tabular criteria. It can
automatically generate buffers around features like sensitive land use types. Any
analysis which uses map data can make use of GIS. Applications for GIS include
resource assessment and management, habitat assessment, development planning,
waste management site analysis, infrastructure and environmental impact analysis,
and urban land records analysis [41]. GIS technology can be used for scientific
investigations, resource management, and development planning. For example, a GIS
might allow emergency planners to easily calculate emergency response times in the
event of a natural disaster, or a GIS migﬁt be used to find wetlands that need
protection from pollution [42].

In general, the most effective and efficient GIS is one that is integrated with the rest
of an organization's information technology (hardware, software and databases) and

one that is shared and/or coordinated across multiple agencies. The power of GIS is
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most apparent when the quantity of data involved is too large to be efficiently
handled manually. There may be thousands of features to be considered, and
hundreds of factors associated with each feature or location. This information may be
stored on a multitude of maps, paper tabular files, computerized databases, and/or
large lists of names and addresses. With GIS, all of this information can be brought
into the same system and the interrelationships of the numerous features and their

characteristics analyzed as they relate to a given problem [35].

3.3.1. Graphical display of data and its implications

One of the most powerful capabilities of a GIS is its ability to graphically display
data or information related to public policy decisions. The capability to link tabular
data to related maps or other graphic displays of the data is a powerful
communication tool that turns raw data into useable information [35]. For example,
one view in your project that displays a city’s census tracts classified by population,
and another view that shows just the outlines of these census tracts, as shown in

Figure 3.1.

3.3.2. Neighborhood analysis

Another powerful capability of a GIS is the ability to identify and/or analyze
phenomenon based on their physical proximity or being in the same neighborhood.
The spatial or locational component of GIS enables the user to accomplish several
types of analyses or applications that would be difficult without reference to location.
Neighborhood function analyzes the relationship between an object and similar
surrounding objects. A new map is created by computing the value assigned to a
location as a function of the independent values surrounding that location.
Neighborhood functions are particularly valuable in evaluating the character of a

local area.

16



Graph of. _3DStates

Alaska Ny
Alabama >
Arkansas N
Arizona "N

California Pop_teeo

O

Pop_1990

32000000
28000000

J0000000

i

581082
1866582 105909 549180
799085 4375099
Pop_65Plus
(@) s000000
© 2500000
° 500000
US Population 2000

11400000 to 29800000 (6)
6200000 to 11400000 (5
6200000 (4]

BP|_1990
Num_Hh_90

Arkansas
Arizona ~
California

184539
2368857 1227928
17990455

19100001
3700000 to
200000010 3700000 (7] 621111
153000010 3181568 4877185
80000010 1500000 (8) | 29760021 4
40000010 800000 1728111
16986510 23:73“7'5’1‘4 2419041
12937926
o X
State_Neme State |Pop_1990  |Nurm_Hh_30 |BPI_19950 Sales_1990 |
Of ateska AK 550043 188,915 02446 4668675
| Atenams AL 4040587 | 1 .506,790 14017 | 26373205
Ol anansas AR 2350725 21,179 02111 15386039
[ arizana AZ 3665228 1368843 13875| 28137116
_ Calitornia CA 28760021 | 10381206 125833 | 225,065 880
lisT
240000000 (il e
200000000 240000000
160000000 200 KO
120000000 180000000
80000000 120000000
40000000 80000000
40000000
0
Alaska
l\l;bama Sales_1890

Figure 3.1 A view capabilities of GIS (from Maplnfo® professional user guide)
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3.3.3. Overlay analysis

Within a GIS, this locational or physical proximity information can also be used to
overlay several different types of information and analyze their interaction as it
relates to a given problem. In GIS, the different types of information relevant to a
particular problem are organized into separate digital data layers. The overlay

function creates composite maps by combining diverse data sets.

The overlay function can perform simple operations such as laying a road map over a
map of local wetlands and adding map attributes of different value to determine
averages and co-occurrences. This feature of GIS allows information on completely
different types of features, from different information sources, to be brought together
and analyzed for how they might interact and impact on a particular phenomenon of
concern. A similar approach could be used with GIS for a wide variety of types of
data layers and a wide variety of applications [35]. For example, one might map
optimum sites for potential manufacturing plant development based on the
interaction of data layers such as: streets and highways, railroads, utilities, zoning,
vacant lots, distance to suppliers, location of trained workforce, etc. Figure 3.2
illustrates how this overlay technique might be applied to analyze the potential for

soil erosion.

Geographic Information Swstems

DCAWED DATA ANALYSIS

y ey
]
Qwrershiz |
K |
, Patenia
Mydialogy

P Sail Erasian
Tapegrapny, o~ ;
Baith. o

Lang Cower- o~

Base Map. o~ =

d

Figure 3.2 Tllustration of overlay capabilities of GIS



3.3.4. Storing and retrieving maps

GIS allows these maps to be stored digitally and updated on an on-going basis. These
digitally stored maps can be printed out to produce an up-to-date version upon
request either by the department that maintains the map information or by another
department that shares a common computer network. Specific attribute information
about a given feature on a map, such as the traffic volume on a given road, can also
be accessed via computer [35]. This fundamental capability of GIS can provide a
great deal of increased efficiency, and eliminate unnecessary redundancy in many

operations.

Essentially, any set of data that has a spatial extent and is referenced with a
geographic identifier- such as an address, parcel ID, or latitude/longitude- can be
utilized in a GIS to answer questions and solve problems. A GIS typically addresses
questions and problems related to location proximity, conditions, trends and patterns.
Additionally, a GIS can be used to perform analytical operations to support decision-
making processes, such as site suitability analyses for future landfills or soil erosion
potential within a specific region. A GIS can also answer "what if...?" questions
based on different scenarios and situations. A GIS can be used to automate existing
operations (e.g., map production and maintenance), as well as provide enhanced
capability to analyze geographic information for decision-making purposes. One of
the most powerful features of a GIS is its ability to simultaneously use multiple
discrete spatial data sets to answer questions that were previously impossible to
answer using conventional mapping methods. By inputting spatial information into a
GIS, we can query data based on its location in the real world. When we link our
spatially referenced data to an existing database and query based on a geographic
identifier and attribute, we add another dimension to our query, giving us results
impossible to achieve from a database alone. When used as a result of proper
planning and attention to detail, a GIS allows the end user to make better decisions
quicker, and provides planners, engineers and technicians with the ability to make
sense out of data that may otherwise be overlooked [43]. A GIS combines the best of
map-making with the best of database management, resulting in a powerful

combination of visual and computational analysis.
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3.4. How Does GIS Work?

GIS stores information about the world as a collection of thematic layers that can be
linked together by geography. This simple but powerful and versatile concept has
proven invaluable for solving many real-world problems from tracking delivery
vehicles, to recording details of planning applications, to modeling global
atmospheric circulation [44]. By default a theme represents all the features of a
particular feature class that the data source is based on. It is useful to be able to
restrict a theme to represent only a desired subset of the features displayed in a
particular feature class. For example, you might have a data source that contains arcs
for all the roads in your study area, but you want to create a theme that only

represents the major highways. In this case, you would first add the theme to your

view then set its theme properties to define a feature selection consisting of the major

highways.
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Figure 3.3 Illustrations of sources of GIS
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3.4.1. Relating different sources

A GIS, which can use information from many different sources, in many different
forms can help with such analyses, as shown in Figure 3.3. The primary requirement
for the source data is that the locations for the variables are known. Location may be
annotated by x, y, and z coordinates of longitude, latitude, and elevation, or by such
systems. Any variable that can be located spatially can be fed into a GIS. Different
kinds of data in map form can be entered into a GIS. A GIS can also convert existing
digital information (which may not yet be mapped) into forms it can recognize and

use.

3.4.2. Data capture

If the data to be used are not already in a digital format (something the computer can
recognize), there are various techniques and technologies available to capture the
visible features. The simplest, technologically, is digitizing, hand-tracing the paper
map computer mouse. Electronic scanning devices may be employed to convert map
lines and points to digits. In addition to being costly there are rarely completely
automatic ways to do that. Much of what we can easily recognize reading a map is
very confusing to a scanner. This method is very useful where the number and type
of features are limited, and area contrasts are clear. Data capture -putting the
information into the system- is the time-consuming component of GIS work.
Identities of the objects on the map must be specified, as well as their spatial
relationships. Editing of information that is automatically captured can also be
difficult. Electronic scanners record blemishes on a map just as faithfully as they
record the map features. Although increasing amounts of spatial information are
captured in a digital format (for example, satellite imagery, and aerial photography)
many organizations will have to convert large volumes of information from a paper
format. An example would be a water utility that has to convert its water mains
records (graphical and text based), to digital format. Some of these records might be
up to one hundred years old. Data capture is achieved by manual or automated means
and may involve integrating spatial data from a number of sources, with non-spatial

information such as finance accounts, customer records etc. [42, 45].
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3.4.3. Data integration

A GIS makes it possible to link, or integrate, information that is difficult to associate
through any other means. Thus, a GIS can use combinations of mapped variables to
build and analyze new variables. A GIS can be used to emphasize the spatial
relationships among the objects being mapped. While a computer aided mapping
system may represent a road simply as a line, a GIS may also recognize that road as
the border between wetland and urban development, or as the link between Street A.

and Lane B. [42].

3.4.4. Projection and registration

Map information in a GIS must be manipulated so that it registers, or fits, with
information gathered from other maps. Before the digital data can be analyzed, they
may have to undergo other manipulations - projection conversions, for example - that
integrate them into a GIS. Projection is a fundamental component of mapmaking. A
projection is a mathematical means of transferring information from the Earth's
three-dimensional curved surface to a two-dimensional medium - paper or a
computer screen. Different projections are used for different types of maps because
each projection is particularly appropriate to certain uses. For example, a projection
that accurately represents the shapes of the continents will distort their relative sizes.
Since much of the information in a GIS comes from existing maps, GIS uses the
processing power of the computer to transform digital information, gathered from

sources with different projections to a common projection [42].

3.4.5. Data structures

A GIS must be able to convert data from one structure to another. Image data from a
satellite that has been interpreted by a computer to produce a land use map can be
"read into" the GIS in raster format. Raster data files consist of rows of uniform cells
coded according to data values. An example would be land cover classification.
Raster data files can be manipulated quickly by the computer, but they are often less
detailed an may be less visually appealing than vector data files, which can
approximate the appearance of more traditional hand drafted maps. Vector digital

data have been captured as points, lines (a series of point coordinates), or areas
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(shapes bounded by lines). An example of data typically that is held in a vector file
would be the property boundaries for a housing subdivision [42]. A GIS can perform
data restructuring in order to convert data into different formats. For example, a GIS
may be used to convert a satellite image map to a vector structure by generating lines
around all cells with the same classification, while determining the cell spatial
relationships, such as adjacency or inclusion. Thus a GIS can be used to analyze land

use information in conjunction with property ownership information.

3.4.6. Data modeling

A GIS, however, can be used to depict two- and three-dimensional characteristics of
the Earth's surface, subsurface, and atmosphere from information points. For
example, a GIS can quickly generate a map with lines that indicate rainfall amounts.
Such a map can be thought of as a rainfall contour map. Many sophisticated methods
can estimate the characteristics of surfaces from a limited number of point
measurements. A two-dimensional contour map created from the surface modeling of
rainfall point measurements may be overlain and analyzed with any other map in a

GIS covering the same area [42].

3.4.7. Data output

A critical component of a GIS is its ability to produce graphics on the screen or on
paper that convey the results of analysis to the people who make decisions about
resources. Wall maps and other graphics can be generated, allowing the viewer to
visualize and thereby understand the results of analyses or simulations of potential
events [42]. High quality output in various forms remains important for most GIS
users. Communicating the results of GIS analysis is essential for the effective use of

the technology. Output may take the form of a map; a table; a report or a digital file.

3.4.8. Graphic display techniques

A GIS can combine map types and display them in realistic three-dimensional
perspective views that convey information more effectively and to wider audiences
than traditional, two-dimensional maps. Traditional maps are abstractions of the real

world, a sampling of important elements portrayed on a sheet of paper with symbols
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to represent physical objects. People who use maps must interpret these symbols.
Topographic maps show the shape of land surface with contour lines. Graphic
display techniques in GIS's make relationships among map elements visible,

heightening one's ability to extract and analyze information as shown in Figure 3.4.

"l

Figure 3.4 Graphic display techniques (from Maplnfo® Professional User Guide)

3.5. Three Unique Concepts of GIS

3.5.1 Discrete thematic data layers

A map view is an interactive map that lets display, explore, query, and analyze
geographic data. A view is actually a collection of themes. A theme represents a
distinct set of geographic features in a particular geographic data source. A view
defines the geographic data that will be used and how it will be displayed, but it does
not contain the geographic data files themselves. Instead, a view references the
sources of the data files. A view is dynamic, because it reflects the current status of
the source data. If the source data changes, a view that uses this data will
automatically reflect the change, the next time the view is drawn. It also means that

the same data can be displayed on more than one view, as shown in Figure 3.5.
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3.5.2. Georeferenced data

Once map data have been registered carefully within a common locational reference
system, information displayed on the different layers can be compared and analyzed
in combination. Single locations or areas can be separated from surrounding
locations, by simply cutting all the layers of the desired location from the larger map
[34]. Whether for one location or the entire region, GIS offers a means of searching

for spatial patterns and processes, as shown in Figure 3.6.

3.5.3. Map algebra and data combination

Not all analyses will require using all of the map layers simultaneously. In some
cases, a researcher will use information selectively to consider relationships between
specific layers. Furthermore, information from two or more layers might be
combined and then transformed into a new layer for use in subsequent analyses. This
process of combining and transforming information from different layers is
sometimes called map “algebra™ in so far as it involves adding and subtracting

information as shown in Figure 3.7 [34].
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Figure 3.6 Layers of information collated for a single location

Figure 3.7 Selecting and transforming GIS data by layer

26



3.6. Components of GIS

GIS is a complex system and, as such, it requires more than just the hardware
(computers, etc) and software (computer programs) to make it function. Two other
types of components are necessary for any successful GIS: information or data in the
proper form; and the agencies and trained people working together to make a GIS a
success. Indeed, most GIS analysts would assert that the most challenging aspects of
building a successful GIS are the development and maintenance the proper data and
securing the cooperation of multiple agencies and retaining trained-experienced

people [35].

As shown in Figure 3.8, GIS constitutes of five key components:

e Hardware

* Software
e Data

+ People

s Method

Figure 3.8 Components of GIS
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3.6.1. Hardware

Hardware is the computer on which a GIS operates. It consists of the computer
system on which the GIS software will run. The computer forms the backbone of the
GIS hardware, which gets its input through a scanner or a digitizer board. The
scanner converts a picture into a digital image for further processing. The output of
scanner can be stored in many formats e.g. TIFF, BMP, JPG etc. A digitizer board is
flat board used for vectorisation of a given map objects. Printers and plotters are the
most common output devices for a GIS hardware setup. Another important hardware
component is GPS (Global Positioning System) which is a satellite-based system that
can be used to locate positions anywhere on the earth. A GPS receiver calculates its
position by a technique called satellite ranging, which involves measuring the
distance between the GPS receiver and the GPS satellites it is tracking. The range or
distance is measured as elapsed transit time. The position of each satellite is known,
and the satellites transmit their positions as part of the "messages" they send via
radio waves. The GPS receiver on the ground is the unknown point, and must

compute its position based on the information it receives from the satellites.
3.6.2. Software

GIS software’s in use are MaplInfo®, ARC/Info®, AutoCAD® Map, NetCAD® etc.
The software available can be said to be application specific. MapInfo® may be a
suitable option and it is easy to use and supports many GIS feature. If the user
intends to carry out extensive analysis on GIS, ARC/Info® may be a preferred option.
For the people using AutoCAD® and willing to step into GIS, AutoCAD® Map is
good option. GIS software provides the functions and tools needed to store, analyze,
and display geographic information.

Key software components are;

a) Tools for the input and manipulation of geographic information
b) A database management system (DBMS)

¢) Tools that support geographic query, analysis, and visualization
d) A graphical user interface
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3.6.3. Data

Geographic data and related tabular data can be collected in-house or purchased from
a commercial data provider. The digital map forms the basic data input for GIS.
Tabular data related to the map objects can also be attached to the digital data. A GIS
will integrate spatial data with other data resources and can even use a DBMS, used

by most organization to maintain their data, to manage spatial data.

3.6.4. People

GIS technology is of limited value without the people who manage the system and
develop plans for applying it to real-world problems. GIS users range from technical
specialists who design and maintain the system to those who use it to help them
perform their everyday work. The people who use GIS can be broadly classified into
two classes. The CAD/GIS operator, whose work is to vectorise the map objects. The
use of this vectorised data to perform query, analysis or any other work is the

responsibility of a GIS engineer/user.

3.6.5. Method

A successful GIS operates according to a well-designed plan and business rules,
which are the models and operating practices unique to each organization. There are
various techniques used for map creation and further usage for any project. The map
creation can either be automated raster to vector creator or it can be manually
vectorised using the scanned images. The source of these digital maps can be either

map prepared by any survey agency or satellite imagery.

3.7. Advantages of GIS

A GIS is a computer-based tool for mapping and analyzing things that exist and
events that happen on Earth. GIS technology integrates common database operations

such as query and statistical analysis with the unique visualization and geographic
analysis benefits offered by maps. These abilities distinguish GIS from other
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information systems and make it valuable to a wide range of public and private

enterprises for explaining events, predicting outcomes, and planning strategies [44].

A GIS is an integration of computer hardware and software, which can create,
manipulate, and analyze a geographically referenced database to produce new maps
and tabular data. GIS includes the capabilities of computer aided design (CAD) and
database management systems (DBMS), but is more than just a combination of those
systems. In a GIS, a relationship between the graphic map data and the tabular
database is maintained so that changes to the map are reflected in the database. GIS
allows automatic determination of the relationships between maps, and can create

new maps of those relationships.

The traditional method of preparing and analyzing environmental and planning maps
has been to overlay thematic maps manually to choose areas of coinciding
constraints and opportunities. Engineers managing infrastructure have compiled
facilities data manually, drafting on large scale street map bases. The difficulties with
the manual overlay method include registering maps which may be published at
different scales or projections. The more layers of maps included in the analysis and
the more complex they are, the more the likelihood of human error entering the
analysis and the longer the process takes. The GIS can take maps from different
sources and register them easily and is consistent in its analysis of multiple layers of
map data. It is also faster than manual methods of analysis, allowing the flexibility to
try alternate variables in analysis [34].

GIS integrates spatial and other kinds of information within one system: it offers a
consistent framework for analyzing space. GIS makes connections between activities
based on spatial proximity. GIS provides the mechanisms for undertaking the
manipulation, analysis and display of geographic knowledge [45]. The availability of
GIS has increased the importance and utility of the geographic component of the
information that governments routinely collect and maintain. GIS adds a powerful
package of tools to an organization's information technology capability because of its
ability to integrate and analyze diverse types of information based on the physical

location or proximity of the various features or characteristics [35].
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Computational functions of a GIS system are following

SR

e.
f.

Data Acquisition & Verification
Data Compilation

Data Storage

Data Update & Manipulation
Data Management & Exchange
Data Retrieval & Presentation

g. Analysis & Combination

And GIS as a set of interrelated subsystems:

e P

a o

5 @ oo

Spatial and Attribute Data Base
Cartographic Display System
Map Digitizing System
Database Management System
Geographic Analysis System
Image Processing System
Statistical Analysis System
Decision Support System

3.8. Decision Making and GIS

Firstly, and most importantly, a GIS is an information system. A system is a group of
connected entities and activities which interact for a common purpose. An
information system is a set of processes, executed on raw data, to produce
information, which will be useful in decision-making. The development of IT
(information technology) tools to support decision-making has matured in the 1990s.
GIS is one of many systems available to the decision maker. It is important to
remember, however, that there is a problem with the declared aim of GIS to improve
decision-making: How do you measure what is a good decision and what are the
feedback mechanisms to put right a poor decision? This is a complex area, which
needs addressing. GIS has focused on the technology and more recently, on the

information, but not on how they are used to the best effect in decision- making.
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Systems are established to monitor the information flow and decision making nodes
in many organizations. These provide ways of informing people about the success or
otherwise of decisions they make, of the knock-on effects, and help to determine

remedial action where necessary.

Measuring the success of a GIS in the decision making process may prove to be
difficult to quantify, and this difficulty has certainly been recognized in the literature
concerning cost-benefit analysis of GIS. There is, however, recognition that just the
graphics alone, including maps, can be very beneficial as an aid in making decisions.
For example, the use of an ortho-corrected aerial photograph, overlaid with property
polygons, by a planning committee could increase the understanding of, say, the
limitations of potential sites for development [45]. An added problem, however, is
that many people are not particularly spatially aware, having had little formal
experience of using spatial information. Some individuals may even find it
impossible to understand map-based information. Thus there is a need to consider
improved methods of spatial data representation and aids to spatial data
interpretation. Once again the use of multimedia technology and aerial photography

could have a role to play in improving our spatial awareness.

3.9. GIS Applications

Some important application areas of GIS are following
» Landscape Ecology
« Geography

o Cartography

+ Remote Sensing

« Photogrammetry

o Surveying

o Geodesy

» Statistics

« Operations Research
« Computer Science

« Mathematics
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GIS usage by Industry:

Agriculture: Allows for site-specific analyses of physical, chemical and crop data

that can determine the cause of yield variations.

Banking & Insurance: Allows banking institutions to target appropriate marketing

and advertising resources to their customers based on their purchasing habits.

Defense & Intelligence: Allows defense agencies to present a wide variety of
information onto one map, allowing for a more efficient level analysis of

information. Also used to show troop dispositions, status, and routes of movement.

Electric and Gas Utilities: Allows Utility companies to maximize efficiency

through direct knowledge of the location of current and potential clientele.

Environmental Conservation & Management: Allows environmental agencies to
monitor environmental issues using existing spatial and attribute data. It also allows

them to monitor potentially dangerous industries.

Federal Government: Allows federal agencies to become more efficient through the

use of current geographical information.

Forestry: Allows foresters to monitor and make decisions about the resources in a

certain area from a global viewpoint.

Health: Allows medical facilities to provide customers with a direct knowledge of

health care locations ranging from nursing homes to pharmacies.

K-12 Education: Allows teachers to enhance the lessons of the classroom by
providing useful maps, and representations that were previously not available with

the “static” wall maps that are currently in use in many schools today.

Law Enforcement/Criminal Justice: Allows multiple sources to input information

on criminal activity and emergency response that can be analyzed visually.
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Libraries & Museums: Allows libraries and museums to manage and present

information in a way that is easier to understand.

Logistics/Vehicle Management: Allows delivery of goods to be more efficient by
knowing where the product is at all times. It also allows helps eliminating waste from

the delivery process as a whole.

Petroleum: Allows data-basing of information such as recourse location, and

pipeline/well configuration to be presented on a digital map.

Pipeline: Allows pipeline owners/operators to plan routes and construction paths,

flow efficiencies, pipeline integrity and supply analysis.

Public Safety: Facilitates the planning of emergency responses, dispatch critical

information to response vehicles, and predict a future event based on past events.

Real Estate: Allows the real estate industry to organize information about residential

areas into a map that can be easily understood by themselves and clients.

Retail & Commercial Business: Allows business professionals to display sales

trends and patterns based on geographic information from different sources.

State & Local Government: Allows state and local agencies to become more

efficient through the use of current geographical information.
Telecommunications: Allows Telecommunications companies to maximize
efficiency through direct knowledge of the location of current and potential clientele.

It also allows them to display information about networking strategies.

Transportation: GIS allows for the tracking and routing of vehicles, inventory

tracking, and infrastructure management.
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Water & Wastewater: Allows water and sewer utilities to keep track of the
locations and conditions of water mains, meters, valves, hydrants, and other

maintenance facilities [46].

In all of these applications, the location of some features or characteristics in relation
to other features is an important consideration. A GIS allows a user to associate this
feature location information with other types of information that are important
relative to the particular application.

Before GIS technology, only a few people had the skills necessary to use geographic
information to help with decision-making and problem solving. Today, GIS is a
multi-billion-dollar industry employing hundreds of thousands of people worldwide.
GIS is taught in schools, colleges, and universities throughout the world.
Professionals in many fields are increasingly aware of the advantages of thinking and
working geographically. The future of GIS and the internet would have to be GIS in
today’s network information technology infrastructure. A network-oriented
geographic information system would be used to fill the demand of providing GIS
functionality on the Net by way of the World Wide Web.
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CHAPTER1V

A GIS BASED APPLICATION FOR ELECTRICITY DISTRIBUTION
NETWORK in GAZIANTEP

4.1. Introduction
In this chapter each stage of the application is explained and shown with examples.

One of the most frequently utilized capabilities of GIS is its ability to store, modify
and retrieve maps digitally. Much of the routine work of the public foundations or
companies involves maps, thousands of maps. The information on these maps is
constantly changing, requiring the maps to be modified or completely redrawn to
keep current. This is a very expensive and labor-time consuming process. In addition,
one department may produce a given map and it may be used by another department,
but whose latest version of the map may no longer be up-to-date. This can lead to
costly errors and lost time for all involved. In order to eliminate this problem in
1999, TEDAS GAZIANTEP decided to transfer electricity distribution network to
GIS medium. Steps of the application process are shown in Figure 4.1.

4.2. Production of the Digital Map of Gaziantep

GIS can use information from many different sources. In GIS, with suitable data
standard, it is possible to transfer data from other GIS. Because it is more logical to
update digitally obtained geographical data then to redigitized. In other words if the
city development plan involving streets, districts and subdistrict had been digitally
prepared by local authorities’ beforehand, integration of electrical network with these
plans in the form of layers would have been much easier and economical. But this
had not been realized in the case of Gaziantep and thus TEDAS GAZIANTEP has
pioneered this activity. Before digitizing process of electrical network, it had been
necessary to set up Urban Information System. Many layers pertinent to the city had

been formed. To serve this purpose Maplnfo® software was used.
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Obtaining the paper maps

-
Scanning
v
Registering raster images (details in Appendix I)
v
Digitizing
L 2
Producing map grid
L7
Classification and registering data from paper maps (UIS)
L 2
Projection-Convert process
L 2
Collecting data on survey with the support of GPS (details in Appendix II)
v
Transferring data from GPS to the PC (details in Appendix II)
v
Classification and registering data (electricity equipment)
v
Forming query modules (details in Appendix IIT)
v

Forming calculation and maintenance modules (details in Appendix IV)

Figure 4.1 Steps of the application process

All utility planning activities related to the city should be based on the master
development plan. For this purpose, the most suitable means are city development
maps. These plans are usually prepared in 1/1000 scales. However the number of
these maps varies from 100 to 500 for a medium sized city. If these maps are not

digitized, tracing the network as whole unit by bringing all these maps together is

almost impossible. When going to larger scales, the details and accuracy are lost.

As a first task, paper maps were compiled from the Greater Municipality of
Gaziantep and subdistricts by TEDAS GAZIANTEP GIS department. All these maps

were scanned. After that all the data on paper maps was scanned and digitized on the

screen as shown in Figure 4.2. (Details in Appendix )
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Figure 4.3 A view of Gaziantep City Development Grid
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In addition, a city map grid was produced in order to facilitate utilizing these maps
and subdistricts name were added to the Grid database. In this way, it has become
easier to draw the maps and to enter database information on to the Grids, as shown

in Figure 4.3.
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Figure 4.4 A view of digitized maps

By using GIS, all the development maps were integrated to one layer after been
digitized. Consequently this has relieved burden of spending a lot of time seeking
maps a lot of time seeking maps of the districts and reaching the development plan
information of a particular district has become a matter of seconds. The number of
1/1000 scale maps digitized for the central part of Gaziantep city is about 500, as
shown in Figure 4.4 and that of 1/25000 scale maps digitized for suburban areas is

about 50. (Digitizing process is still in progress).
Small area or spatial, forecasting is the prediction of both the amounts and locations

of future electric load growth in a manner suitable for distribution planning which

really means with geographic resolution adequate for planning a new distribution
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network or extensions to the existing one. The procedure is based on dividing a
utility service area into a number of sufficiently "small arcas" and projecting the
future load in each one. This is usually accomplished by dividing a utility service
area into either a grid of uniformly sized rectangular "cells", or into "equipment

oriented" areas corresponding to feeder or substation areas [47-50].

During digitizing phase, all the information on the maps were classified and
registered in the related layers. For example, health institutes were registered on the
hospital layer; streets and boulevards were registered on the street layer etc. Together

with specific attributes (names of street, hospital), as shown in Figure 4.5.
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Figure 4.5 A view of Urban Information System of Gaziantep

The maps prepared with local coordinates were projection-converted to countries
coordinate system with a tool which is supported by Maplnfo® Turkey distributor

firm.

With the accuracy of city development plan obtained with the support of GPS was
cross-checked. GIS should not be confused with a related technology, GPS which
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uses satellite signals to determine one's position or location on the earth's surface.
GPS receivers are frequently used in conjunction with a GIS to determine the
location (or coordinates) of features so that these coordinate can then be entered into

a GIS for display or analysis of those features. (Details in Appendix II)

After forming the Urban Information System, layers related to electricity network
were formed. Primary substation, distribution substation, transformers, transformers
on the poles, conductors were transferred to the GIS medium according to their
current locations and layers. In this study, thirty layers are actively updated and

located on the layers according to attributes as shown in Figure 4.6.

g7 »  Grid
»  Development Line
7 > Development Poly
7 " District
y ", Primary Substations
/ '; Streets

Distribution Substations
Transformers

» MV Line

i LV Line

»  Poles
s
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g
>
>

>
>

Figure 4.6 Formation of current layers

To carry out any operation on electricity network, a user may not need to deal with
information not pertinent to a specific operation so the user can discard the
information on other layers. The user can eliminate the information on the layer he
doesn’t need or recall the information only on the layer he needs. That is, depending
on the nature of the task and the details needed the user can focus on a specific layer.

(Transformers layer, poles layer, different voltage layers etc.)
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The layers should be determined during the GIS establishment phase or should be
revised according to the requirements in later phases. One of the most significant
characteristics of GIS is that data are stored in layers and there is no restrictions
concerning the number of layers. Thus, the new layers can be added into the system

easily. The current layers are shown in Figure 4.7.
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Figure 4.7 A view of created layers in Maplnfo®
4.3. Layers and GIS Query Modules

Queries are set by the software operator and define a certain set of attributes. This
option allows us to selection of features by defining a query based on their attributes.
During studies need to conduct detailed search related to layers arose. To serve this
purpose, search-find modules were written with the help of Mapbasic®. (Details in

Appendix IIT)

Villages: A layer was formed by specifying the names and locations of 500 villages,

as shown in Figure 4.8.

Districts: A layer was formed by specifying the names, boundaries of 169 districts,

as shown in Figure 4.9.
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Addresses: The names of 3800 streets were obtained from their actual site and were

formed into a layer, as shown in Figure 4.10.

Hospitals: All the hospitals and health organizations were collected on a layer, as

shown in Figure 4.11.

Mosques: 125 mosques were digitized with their names and a layer was formed, as

shown in Figure 4.12.

Schools: 190 schools were collected on a layer, as shown in Figure 4.13.

Government Offices: All the government offices were classified and collected on a

layer, as shown in Figure 4.14.

Police Stations: Police stations were also digitized and collected on a layer.
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Figure 4.8 Villages
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Figure 4.9 Districts
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4.4. Medium Voltage Layer

Gaziantep electricity distribution network utilizes two different medium voltage
levels (15kV and 30kV). 2900 km medium voltage lines were digitized and as
default for 15kV red, for 30kV blue color are used. That is, the voltage levels are
symbolized by red and blue color, as shown in Figure 4.15. In addition, feeder names
are input to the attributes table of “medium voltage layer”. By this way the network
can be colorized by the feeder names. Each feeder path, district supplied by the
feeder, and the related transformers can easily be viewed as in Figure 4.16.
Underground cables are shown by dashed lines and colorized as to voltage level.
Besides, as it can be seen from the attributes table, 3" party customer lines can be
distinguished. The attributes table formed for medium voltage layer is shown in

Figure 4.17.

A 30 kY, Pole Type, TEDAS Transformer

. 30 kY, Indoor Type, TEDAS Transformer
(8 30 kv, Indoor Type, Private Customer Transformer

_& 30 k¥, Pole Type, Private Customer Transformer
4 15 kv, Pole Type, TEDAS Transformer

. 15 k¥, Indoor Type, TEDAS Transformer

@ 15 kY, Indoor Type, Private Customer Transformer
@ 15 kY, Pole Type, Private Customer Transformer

® Pole, MV
@ Pole, LV
30 k¥, Medium Voltage Line
15 KV, Medium Voltage Line
———————————— 30 kV, Medium Voltage Line, Underground
———————————— 15 kv, Medium Voltage Line, Underground
3 School
«=w  Police Station
=  Fire Department
2 Mosque

Figure 4.15 Legend
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Figure 4.17 Medium voltage layer attributes table
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4.5. Low Voltage Line Layer
1220 km low voltage line was digitized and recorded with their attributes as in
Figure 4.18. Green color is used for low voltage lines as default.
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Figure 4.18 A view of low voltage line
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4.6. Transformers Layer

To represent transformers, symbol of triangle or polygon is used. While pole-type of
transformers is symbolized triangle, indoor type of one’s is symbolized by polygon.
Transformers are also colorized as to their supplying source, which is blue for 30kV
and red for 15kV. To distinguish between difference customer and TEDAS
transformers, different symbols of triangle and polygon are formed, as shown in

I'igure 4.19. This legend is easy to understand for every electrician, as in I' igure 4.15.
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Figure 4.19 Transformer layer

5200 transformers are classified and coordinated as the ones belonging to TEDAS
and 3" party (private customers) and digitized by adding used pole type, construction
type, power, brand, serial number, production year, subscriber no, subscriber name,
energy counter brand, energy counter serial number attributes. All transformers have
been located using GPS. Attributes table formed for transformer layer, as shown in
Figure 4.20 and 4.21.
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Especially, when dealing with the 3™ party customers’ transformers information such

as energy counter brand is input as in Figure 4.22. Readouts from each energy

counter is planned to be an input for the developed system database in order to

estimate and analysis a load curve for subscribers in the future.

After collecting the monthly or seasonal energy consumption habit in the database

this data can be used for the best planning and decision-making for the feeder. For

instance n years later the cross-sectional area of conductor type can be improved or

the feeder load can be splitted. Private transformer info tool is shown in Figure 4.23.
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Figure 4.22 Private transformer and attribute’s table
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Figure 4.23 Private transformer attribute table

4.6.1. Unique code system

In city center, Gaziantep, there exist 900 transformers which belong to TEDAS and
they are mostly named with their street location (as next to X mosque, in the vicinity
of Y police station, Z hospital) by the TEDAS staff. As it is well known, Gaziantep is
a metropolitan city and gets huge amount of migration. By time new districts are
formed and street names are continuously changing. That is why a new coding
system has been developed for transformers. This new developed coding system
gives a unique number to each transformer defined in city development plan by the
location in (1/5000) scale as N38c18d-020. In this code system, first seven digits
show the name of the city development maps of scale 1/5000 and last tree digits
show the number of transformers on this map. As this is the one and only factor not
changing which defines the location of the transformers. Info tool of TEDAS

transformers can be seen in Figure 4.21.

53



4.6.2. Reporting tools

While digitizing, the transformers must certainly classify as TEDAS and 3" party
customer. During this study TEDAS and 3" party customers were combined into a
single transformer layer, but it is also possible to classify them in separate layers.
Because, in analysis and planning phase is a crucially important point. It is the main
principle of “Find Transformer” query module which was developed specifically for
this study written in Mapbasic®. (Figure 4.24, 4.25, 4.26) (details in Appendix III-
V)

This developed module can find the information for the required transformer in less
than 1 sec. This module is mostly used during planning sessions as TEDAS
Gaziantep has approximately 7000 transformers. As it can be seen in Figures 4.25
and 4.26, all recorded customers can be found using “Find Transformer” and the all

attributes of transformers are recalled immediately.
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Figure 4.24 Geographical query module of TEDAS transformers
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From time to time, the system needs reporting requirements. With respect to this
matter GIS’s (Maplnfo) SQL database management system provides significant
convenience. The data in the database can be examined easily by SQL’s SELECT
command. This selection is a subset of data rows in a table, chosen based on the
contents of one or more columns from the table. We create selections by formulating

questions, or queries, about our data.

With respect to transformer size, geographic locations, etc. constraints very useful
reports can be produced. For example; using Maplnfo’s Sql’s Select command,
selection of TEDAS’s transformer with voltage level of 30kV and size of 630 kVA
takes only 1-2 seconds as shown in Figure 4.27. Furthermore, the locations of
transformers can be found geographically. This kind of reports usually needed in
TEDAS’s planning department. Because of this kind of reports is used as decision
support system. If GIS was not used, obtaining this knowledge will be labor

consuming process and perhaps the results will be unreliable.
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4.6.3 Maintenance tool

As mentioned before, electricity distribution network has a dynamic structure. Loads
vary with time of the day, day of the week, and season. In some periods the demand
to electricity are extreme, for example, in winter the transformers breakdown 3 of 4
times of a week and must be changed instantly. If TEDAS has not enough
transformers in its warehouse, it must use a bigger size transformer instead of broken
transformer. For example, it may be installed a 160 kVA transformer instead of a 100
kVA transformer, or a 400 kVA transformer instead of a 250 kVA transformer. As a
result of this process, idle capacity and high costs are occurred. Each year TEDAS
includes roughly 30-40 transformers into the network, in other words the electricity
equipments in the survey changes constantly. Before GIS, what kind of process was
exposed to which transformer can not be known with time, due to lack of reliable
data. As a result, It can not be forecasted which size of transformers needed and how

many transformers needed in which period?

By using GIS, a new tool was also developed for maintenance planning gathering
statistical data. By this way reason of transformer failures and maintenances done are
recorded and this information can be accessed with a mouse click as in Figure 4.29.

(for details see Appendix IV)

In order to this tool, statistical data which is required for an inventory planning and
control subsystem can be collected. Therefore, spare parts can be forecasted
accurately and also can be ordered beforchand. In this way, maintenance process can

be managed by lower cost and in a short time.

In addition, the images of transformers are associated with the transformer layers as

in Figure 4.29.
4.7. Poles Layer

Poles are located on one layer as medium voltage poles and low voltage poles.
Attributes are input for TEDAS and 3™ party customers and their types.
Approximately 15000 poles have been digitally registered. Poles layer attributes
table is as in Figure 4.30 and 4.31.
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4.8. Voltage Drop, Power Loss, Calculation of K and C Coefficients

The electricity distribution planner is usually restricted by permissible voltage
values, voltage dips, flicker, etc. as well as service continuity and reliability. The
planner ultimately has a significant influence on additions to and/or modifications of
the subtransmission network, locations and sizes substations, service areas of
substations, location of breakers and switches, sizes of feeders and laterals, voltage
levels and voltage drops in the system, the location of capacitors and voltage

regulators the loading of transformers and feeders.

The location of substation is dictated by the voltage levels, voltage regulation
considerations, subtransmission costs, substation costs and the costs of primary

feeders, mains and distribution transformers.

As discussed above electrical calculations are the main points for the electricity
distribution planning works. As the body is dynamically changing and growing. On
electricity distribution network of Gaziantep, the distribution is done via five
different types of conductor in medium voltage level, three different types of
conductor forms (Table 4.1) and two different voltage levels (30kV and 15kV). In
the network continuous additions occur and new transformers with different types
and voltage ratings are integrated to the network. As the network expands electrical
calculations become cumbersome. For example for any point a feeder which has 60-
70 transformers on it and which is thirty km in length voltage drop and power loss
calculations may take days. Because on calculations the size of the transformers,
number of branching, transformers on each branch, connection point of transformers
on the line and conductor type used on the branch are to be regarded carefully. Those
data must be valid in case of quantity, quality and accuracy of data. Additionally
during these calculations highly complex formulas are to be used. The derivations of

those formulas are below.

UNITS :
P=kW Power
N=kVA Apparent Power
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I=A Current

L=km Length of Line
Ro=Q/km Resistance of Conductor at 20°C
Xi= Q/km Inductive Reactance
U=kV Line Voltage

f=Hz Frequency

r=mm Conductor Radius

d=cm Geometric Mean Distance
A = (H.km/phase) Inductance

Cosp=0.8

K: Coefticient

C: Coefficient

4.8.1. Absolute voltage drop
AU=LI 43 (Ry Cosp + Xy Sing) [ Volt] (4.1)

4.8.2. Relative voltage drop

Voltage drop is the difference between the voltage at the transmitting and receiving
ends of a feeder, main or service. Percent voltage drop is the ratio of voltage drop in
a circuit to voltage delivered by the circuit, multiplied by 100 to convert to percent.
Voltage Drop Analysis Tool : Calculates the voltage drop over the radial configured
medium voltage distribution system network for present status and in case of adding

new transformer centers, loads or cables.

AU 100 _ LN(R, Cosp+X,Sing )

%e = - 107 = 4.2)
U 10 U

%e = LNZ Cosp (R +X; Tanp) = (4.2a)
10U

Cosp=0.8 =
LN

%e= — 0.8 (Ry+X.0.75) = 4.2b

o T, (Rg +X1.0.75) (4.2b)
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%e = LU—N 0.08 (Rp+X.0.75) =

0.08 (R, +X, 0.75)

2

et

10K

%e= LN

%e=LN 10°K %e<%10 must be.

4.8.3. Calculation of K

ok~ 008 (ROUJ;XI 0.75)

XL=2TI1fA

0.08 (R, +(2I1f1) 0.75)

K:
10702

% =[46%og(2)+05710*
n

0.08 {R,, +(2I‘lf [4.6 log((—l)+0.5 ] 10") 0.75
i

K:
107°*U?

4.8.4. Calculation of d

A — STRAIGHT LINE
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(4.2¢)

(4.2d)

(4.2¢)

(4.3)

(4.3a)

(4.3b)

% iy

x 180



B - TRIANGLE LINE

90 cm

d12 = 264 cm
d|3 = 162.78 cm
d3 =240 cm

d=3d, x d; x dy

d=V264 x 162.78 x 240
3 d= 217.67

C - FLAG CONSOLE LINE

d]z = 162.78 cm
di3 = 170.88 cm
dy = 90 cm

d=dldy; x dy x dy
d:§/16278 x 170.88 x 90
d= 135.78
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4.8.5. Medium voltage power loss calculations

Power Loss Analysis Tool: Calculates the power loss and cable suitability for

possible power flows over cables.

N(kVA) =3 Ul =  P(kW)=+3 UI Cosg (4.4)
gy < X B (4.4)
J3Ul N
P
P(kW)=+3 UI Cosp = I= —— (4.4b)
J3u Cosgp
AP=3ER ~H - P IR (4.4¢)
BU Cosgp AU Cosgp
2
ape BN R=Rg L
U
2
ap=Re LZN - R ey (4.4d)
§] U’
10°@
AP=10° C N’L (4.4¢)
4.8.6. Percentage power loss
yieiondy _JO0AR 1004 AR 100 AP @5)
P N Cos¢ Cosp N 0.8 N
AP
%P = S 125 %P has to be lower than %5

In the current system, days-long calculations are not so reliable. In this study using
MaplInfo® intermediate modules for the electrical calculations (Voltage Drop
Analysis Tool - Power Loss Analysis Tool) were developed. Thanks to those
modules time consuming calculations take as less time as seconds, as shown in
Figure 4.32 and 4.33. And expansion scenarios (See Section 4.8) for the new
additions to the distribution network can be developed in less time and optimum

decisions can be made for planning.
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4.9. Case Study: Redesign of Electricity Distribution Network in Kayacik Dam

Reservoir Area

The Kayacik Dam in Oguzeli (Table 4.2) has been constructed by DSI (The General
Directorate of State Hydraulic Works). During construction of the dam 17,4 km* of
land was affected by the dam. The distribution lines, transformers and the electricity
equipments which belong to TEDAS and 3 party customers will be remained under
water. Due to these reasons, DSI apply to TEDAS for taking measures and producing

alternative solutions. Figure 4.34 shows current position of the region.

GIS service of TEDAS Gaziantep have digitized the map of the area before,
producing alternative solutions has been very simple. First, GIS service has asked to
DSI for giving the paper map showing region affected by the dam. Consequently,
digitization of map of scale 1/25,000 has been completed. Furthermore, information
on survey registries was transferred to the database and the dam lake area was
digitized to exhibit this region which will remain under water. Figure 4.35 and Figure

4.36 show the region affected by Dam and remained under water, respectively.
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Figure 4.34 Current position of the region
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Many alternative solutions have been produced in a short time by using GIS without
working on survey. At that time technical constraints, any geographical installation
restrictions, and heuristic rules have been taken into account. When technical
constraints are taken into account voltage drop-power loss calculation tool written by
us have been used. Since digitization of map of scale 1/25,000 are in our database
geographical installation restrictions and heuristic rules have been easily analyzed.
Due to fact that the region is rural region analysis has been very simple according to
urban area. Following heuristic rules for electricity distribution system planning have

been taken into account: [17-19].

Distribution line is curved or discarded if there is a big pond between two load points.
If the line passes through cotton industries, it is curved or discarded.

If the line passes through commercial plantation area, it is curved or discarded.

If the line passes through commercial complex, it is curved or discarded.

If the line passes through the residential area, it is curved or discarded.

Substation location is discarded if the land is too expensive.

Substation location is discarded if it creates social and environmental problem.
Substation location is discarded if it falls nearer to the shopping mall.

Substation is discarded for any geographical installation restrictions.

Substation location is discarded if it falls near to school; children play ground or

boarding.

Moreover, to reduce the investment costs of feeder we have chosen the scenario
including shortest feeder length. As the investment cost is proportional to the feeder
length, the problem of minimizing investment cost reduces to that of minimizing
feeder length. Shortest path is extremely suitable for distribution system planning.
Ownership problem must be taken into account. In addition, line’s nearness to road
must be considered. The developed 4 different scenario was evaluated as seen in
Table 4.3. Factors that are considered in addition to heuristic rules mentioned before,
are as follows:

1) Investment costs

2) Nearness to road

3) Ownership problem,

4) Technical constraints
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Table 4.2 Technical Details of Kayacik Dam

Location Gaziantep-Oguzeli
Purpose Irrigation
Embankment type Earthfill
Dam volume 1858 hm®
Height (from river bed) 50 m
Reservoir volume at normal water surface elevation 116,8 hm®
Reservoir area at normal water surface elevation 13,1 km?
Irrigation Area 13680 ha
Table 4.3 Alternative Scenarios
Investment Cost / Nearness Ownership Technical
Scenarios Feeder Length to Road Problem Constraints
A 14 Km J Low Cost N
B 13 Km Too Far High Cost v
c 15 Km Too Far Low Cost N
D 19 Km J Low Cost Failed

After many scenario have been produced in office we have worked on survey with

GPS and analyze the scenario which yields the best solution. Finally, we have been

decided to realize Scenario A. Red points shown by Lmk in Figure 4.37 have been

obtained by GPS. As a result, 14 km length of feeder shown by red line in Figure

4.38 has been decided to construct. Location of distribution substation shown by

Lmk 001 feeds 25 villages. But when dam is constructed if solution is not produced

it will not feed 18 villages. Therefore, the computations have done for the new

substation and Lmk 006 in Figure 4.37 has been decided the best place to construct

the new substation.
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Figure 4.37 The solution

Without using GIS, this work will go on for weeks but the best decision obtained in 2
work-days by using GIS. In this study, technical constraints, geographical installation
restrictions, and heuristic rules were considered. It would have been impossible to
obtain better results in a very short time if TEDAS Gaziantep had been not using GIS.
It is always confronted with similar problems in distribution of electricity. It is

ensured that the most effective solution to this kind of problems is GIS.

4.10. Results

This study is aimed at to manage the electricity distribution network in a GIS
environment which is managed by conventional methods. Presently, Gaziantep
electricity distribution network is spread out to 6216 km” and can not be controlled.
Nevertheless, it is very difficult to analyze the system entirely. Using GIS is the most
convenient way to overcome this kind of problems, eliminate the negativeness and

provide efficiency
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It is particularly revealed that the Urban Information System must have been
installed during this study. All kind of knowledge related to city is entered to the
system. It is required to manage the database after installing the Urban Information
System and electricity distribution network is saved to GIS environment. Due to this
reason different reporting tools were developed. For example, it was a difficult
problem to find the streets and avenues in a city with 500 villages and 169 districts.
Then, different search-find modules were written. This end-user software tool was
developed by using MapBasic® on the GIS system. Also, 7000 transformer was
located in the city with 390000 subscribers but nobody knows most of the locations
of the transformers exactly. Especially, it is not known how and where the
underground network is located. If somebody wants to know the structure of the
underground network belonging to anywhere, it is found by looking at old drawings
and asking to old staffs. After installing most of the equipments; lines, transformers
and poles in the city to the GIS environment too many scenarios can be produced
with respect to problems solutions. Because, the city can be seen wholly from the
GIS environment. Being successful in selecting the most powerful one among the
scenarios depends on some kinds of calculations. Because, electricity distribution
system has too many constraints such as voltage drop, power loss etc. It is very hard,
tiring and labor intensive to make these calculations. In the current system, days-long
calculations are not so reliable. In this study using Mapinfo® intermediate modules
for the electrical calculations (Voltage Drop and Power Loss Analysis Tools) were
developed. Thanks to those modules time consuming calculations take as less time as
seconds. Now, expansion scenarios for the new additions to the distribution network

can be developed in less time and optimum decisions can be made for planning.

Likewise, from the case study, it is seen that a good solution is found in a very short
time for a redesign problem on a part of electricity distribution network. New system
is adapted easily due to region’s existing condition and electricity network was
digitized beforehand. Information on survey registries was transferred to the database
and the dam lake area was digitized to exhibit the region which will remain under
water. Many alternative solutions (scenarios) have just been produced in a short time
by using GIS according to some technical constraints, geographical installation
restrictions and heuristic rules. Technical constraints have been analyzed easily by

using voltage drop and power loss calculation tools, which are embedded to GIS. On
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the other hand, an expert user has controlled by using the GIS database whether
geographical installation restrictions and heuristic rules constraints are satisfied or
not for any scenario. Thus, it has been possible to achieve better solutions for a

planning problem in the electricity distribution network by using the GIS application.

As a result, a comprehensive GIS application for the electricity distribution planning
problem has been realized in Turkey. Gaziantep electricity distribution network has
been gotten under control by this application. Now the distribution network can be
effectively managed because the GIS application is used as a management
information system. In TEDAS Gaziantep, association process arrangement is
changed after GIS. The association process arrangement in TEDAS Gaziantep after

GIS is shown in Figure 4.38 as follows:

BEFORE GIS AFTER GIS

=f =

Paper Maps

| GPS

GIS Department
Planning-Projection Establishment
Department Department

Operating
Department

Figure 4.38 Association process arrangement in TEDAS Gaziantep after GIS
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CHAPTER YV

CONCLUSIONS

5.1. Discussion

The proposed application in thesis provides an illustration of how GIS technology
can be applied in one typical government office. Numerous other applications are
possible for other government offices such as national police, traffic, public health,
etc. An integrated GIS allows agencies to share data between agencies and frequently
eliminates or minimizes existing duplication of efforts to maintain commonly needed
datasets. This sharing of data also increases the probability of different agencies
making policy decisions based on current and consistent information. The
development of a local government GIS requires a significant investment of public
resources. However, in many instances, some of the required resources are already
being spent to perform applications that a GIS can perform more efficiently. Before
such an investment is undertaken, efforts should be made to plan for how this
investment could be used to meet the multipurpose needs and applications of

multiple government agencies.

5.2. Conclusion

Electricity distribution planning is an important problem for especially the
developing countries. There is chaotic data in an electricity distribution network
problem. These data need to be processed effectively for planning and operating of
an electricity distribution network. Since most of these data are spatial, in this thesis
we presented an application of electricity distribution planning based on GIS for
Gaziantep. Therefore, the electricity distribution model for the city is established
with GIS and GPS support. The digital map of the electricity distribution network is
produced by MapInfo® and some end-user software tools are developed by using
MapBasic® software’s. For electrical analysis, some calculation tools (Voltage Drop

Analysis - Power Loss Analysis), printing tools and a lot of reporting tools (find-
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subscriber, find-transformer, etc.) are developed. Briefly, an application is
developed, which is a modern information system and a tool that manages everyday
tasks related to operating, maintaining, planning, design and actual expansion of the
city’s network.

The GIS Application that we aim to develop for electricity distribution planning is
able to analyze complicated structures of power transmission and distribution
systems that extend from generation centers to customers and also is able to analyze
geographical correlations between these structures. Furthermore, a lot of information
is visually presented for decision makers, which subscriber is supplied from which
pole (and transformer) and how much load it adds on the network. In addition to that,
required operations and updating operations for the network are done by coordinating
planning, foundation with few workers in a short time so that more reliable

information is provided.
5.3. Future Work

While studies on the system is being continued, this database prepared in digital
medium is planned to use as base for TEDAS’s SCADA (Supervisory Control and
Data Acquisition) and ABONE-NET (subscriber information managing system).
Real time control of network on the map is possible in different periods by
connecting it by SCADA system. Also load analysis on the map is possible provided
that the system is connected with SCADA system. Network components are loaded
optimally provided that loading case of transmission line and transformers are
known. The customers can consumes power without exceeding the voltage drop
limits, the customers are informed in the case of out of power. Transmission loss can
be limited with choice of appropriate conductors and transmission of power by
optimally distance. Furthermore, efficiency of transformers is indicated
geographically with subscriber consumption and comparison of transformer
measurements. Therefore, location of illegal electricity consumption usage is
possible to detect. Also, development of mathematical model is being continued for
optimal feeder configuration supported by GIS, optimal conductor size selection and

optimization of selection of location of substation.
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APPENDIX 1

An Introduction to Raster Image Registration

What Is A Raster Image?

A raster image is a type of computerized image that consists of row after row of tiny
dots (pixels). If you have a scanner and scanner software, you can create a raster
image by scanning a paper map. After you scan a map image and store the image in a
file, you can display the file using MapInfo. There are many different raster image
file formats. MapInfo can read the following types of raster image files: JPEG, GIF,
TIFF, PCX, BMP, TGA (Targa), and BIL (SPOT satellite).

What Does It Mean To Register A Raster Image?

When you register a raster map image, you enter map coordinates (e.g.
longitude/latitude degrees), and you indicate which locations on the raster image
correspond to those coordinates. You must register each raster image before
displaying the image in Maplnfo, so that MapInfo can perform geographic

calculations, such as distance and area calculations, when displaying the raster map.

The first time you open a raster image file within MapInfo, MapInfo displays the
Register Raster Image dialog. By completing this dialog, you tell MapInfo how to
register the raster image. MaplInfo stores the raster image's registration information in
a table file for future re-use. The next time you run Maplnfo, you can re-open the
raster table without repeating the registration process. Thus, you only need to register

each raster image once.
Raster image files provided by Maplnfo are already registered. You do not need to

perform the registration process when you display the sample raster data included
with MaplInfo.
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Registering A Raster Image

If you have not yet displayed your raster image in Maplnfo, perform the following
steps to register the image:

1. Choose File > Open Table. the Open Table dialog displays.

2. Choose Raster Images from the File Format drop-down list. Maplnfo displays a

list of raster image files.

3. Choose the raster image file you want to open, and choose Open. Maplnfo
displays the Image Registration dialog. A preview of the raster image appears in the
lower half of the dialog.

4. Specify the image's map projection by choosing the Projection button and

completing the Choose Projection dialog.

If you created the raster image by scanning a paper map, the paper map may contain
information about the map projection used. If you cannot determine the map's

projection, use the default map projection (longitude/latitude). Choose OK.
5. Move the mouse cursor over the image preview in the lower half of the dialog, to a
spot where you know the map coordinates (e.g. longitude/latitude), and click the

mouse button. MapInfo displays the Add Control Point dialog.

6. Complete the Add Control Point dialog by entering the map coordinates that

correspond to the location where you clicked on the map image. Choose OK.

If you are entering coordinates in degrees, you must enter decimal degrees as

opposed to degrees/minutes/seconds.

7. Repeat steps 5 and 6 until you have entered at least three control points. To ensure

accurate results, enter five or six control points. Each control point that you add helps
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Maplnfo associate earth coordinates with locations on the raster image. Ideally, you

should have at least one control point at or near each corner of the image.

The number of control points needed depends on the nature of your raster image. If
you are not able to determine your map's projection, or if you are working with an
image that does not have an actual map projection, such as an aerial photograph, you

may want to enter twenty or more control points.

8. Choose OK when you are done adding control points. MapInfo displays the raster

image in a Map window.

When you complete the Image Registration dialog, Maplnfo saves the registration
information in a table (.tab) file. In later MapInfo sessions, you can re-open the table
by choosing File > Open Table, without repeating the registration process, and
without having to choose Raster Images as the File Type in the Open Table dialog.

Opening A Registered Raster Image

You only have to register a raster image once. Each subsequent time you open the
file, it can be opened like any other MapInfo table.

The sample raster image files included with MapInfo have already been registered
(contain a TAB file). If you purchased a raster image from another source, it may

already have a TAB file attached. You will not need to register these images either.

To open a registered raster image:

1. Choose File > Open Table.

2. Choose the table file (e.g. Parcels.tab) from the list in the dialog. (The TAB file
contains the control point information supplied during the registration process.)

3. Leave the File Format as it is (Maplnfo). The registration process already created a
Maplnfo readable file (TAB file).

4. Choose Open. Maplnfo opens the raster image table and displays the image in a

Map window.

84



APPENDIX I

How do we use GPS?

Initialization for first time use

One of the basic functions of GPS receivers is to form coordinate information.
Coordinates show variety due to map used in our country. 3 degree in projection of
the map scaled as Gauss-Kruger, 1:1000 and 1:5000 corresponds to 6 degree in
projection of the map scaled as UTM, 1:25000. The GPS products that we use are
able to produce the coordinate for two varieties of systems. All process on GPS (save,
navigation) is done on the system represented as primary and on secondary side

coordinate is obtained visually in selected system.

As explained above coordinate systems show variety but national map datum is
single and it is named as GPS menu as EUR50 or EUROP. Datum refers to the
theoretical mathematical model of the earth’s sea level surface. Map makers may use
a different model to chart their maps, so position coordinates will differ from one
datum to another. The datum for the map you are using can be found in the legend of
the map. If you are unsure of which datum to use, use WGS84. But we must use

European Datum 1950 (EURS0 or EUROP) for our country.

Selecting the coordinate system

To set the coordinate system that will be used to display the position for the “primary
or secondary position screen” on GPS. We must select UTM for Primary and
GAUSS for Secondary coordinate system. UTM is Universal Transverse Mercator
metric grid system used on most large and intermediate scale land topographic charts

and maps.
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A) PRIMARY Settings

i) MENU

ii) SETUP Enter

iii) COORDINATE SYSTEM Enter
iv) PRIMARY Enter

v) UTM Enter

For MAP DATUM

i) MENU

il) SETUP Enter

iiiy MAP DATUM Enter
iv) PRIMARY Enter
v) EURS0 Enter

To set the datum used to compute the coordinates to match the datum used on a map
or chart. If we are using a map or chart with our GPS and the datum do not match,

we may find irregularities when comparing the coordinates.

B) SECONDARY Settings

i) MENU

ii) SETUP Enter

iii) COORDINATE SYSTEM Enter
iv) SECONDARY Enter

v) TRANS MERC Enter

For MAP DATUM

i) MENU

il) SETUP Enter

iil) MAP DATUM Enter
iv)  SECONDARY Enter
v) EURS50 Enter
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If the view of the sky is poor due to large cliffs or buildings, heavy foliage or other
obstructions, the satellite signals can be blocked and the receiver may take longer to
compute a position fix. We must observe the signal strength and the satellites being
used on “Satellite Status Screen” on GPS. Satellite status screen provides us with a
graphical display of the satellites in view and which ones are being used to compute
the navigation data. The bar graph shows us the relative signal strength being
received for each satellite. And then we can mark our points such as waypoint. A
waypoint is a point on a map or a survey that we can name and save in our GPS.
Waypoints are specific geodesic points stored in the GPS receiver’s memory and can
be transferred to the PC using the GPS TrackMaker® program. Usually they
represent specific places, such as poles, transformers, etc. A Waypoint has the

following components:

Latitude

Longitude

Name up to 10 characters
Comments up to 255 characters
Rotation angle of the Waypoint Text
Creation date

Altitude of the Point

Visualization in the screen

W ® N AW N

Specific graphic symbol

After transferred to the PC, all Waypoint data can be modified using the GPS
TrackMaker® program.

Connecting the GPS to PC through Serial Communication Port

GPS TrackMaker® used for the information from GPS to PC or vice versa supports
different formats as ESRI SHP, MAPINFO MIF. Navigation can be done by scanned
background picture. The software supports UTM and geographical coordinate

systems.
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The " Interface " menu allows the user to do the connection between GPS and the

computer through the RS-232 serial communication port.
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How do we integrate to MapInfo™?

Interface ____y Waypoints—__,, Save File X (GPS Trackmaker Text Format *.Txt
~— Open Mapinfo® —» Open Table X (File Type: Delimited ASCI * Txt }—»
Delimited ASCII Information Menu — Choose Other—»  Press OK button
Table Menu (Mapinfo® already open )—Create Points—» Create Points For
table (select X) ___, Choose Symbol ___, Choose Projection —»

Category (Turkish Coordinate System)— Category Members (UTM Central
Meridian 39)—— Then Press OK button—» and add X layer to Mapinfo (Layer

Control) — X Label Options —Label with Column 3
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APPENDIX III

Maplnfo has two commands for selecting objects through querying: Select and SQL

Select. Select is simpler and SQL Select is more powerful.

A) Making Queries Using The Select Command

To make a query:

1. Choose Query > Select, the Select dialog displays.

2. Click on the Select records from table drop-down list and choose the table from
which to select the records.

3. Type your query expression in the that satisfy box, or click the Assist button to
display the Expression dialog which helps you write an expression.

4. Type a name in the Show results in table box for the temporary table that stores
the results of your query or choose selection (the default). If Selection is chosen,

MapInfo automatically names the table Query 1, Query 2 etc.

To sort the query by the value in some column (optional):

5. Click the Sort results by column drop-down list and choose the column containing
the value you want to sort with.
6. Click OK.

A Browser window of your query results displays if the Browse Results box is
checked. You can use Select to highlight objects in a map or a table that meet certain
criteria and create a results table that you can browse, map, or graph like any other

table.

When you are working in a Browser window, the records meeting the criteria of the
query are highlighted.
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When you are working in a map, the graphic objects of the chosen records are

highlighted.

When you are working with both a Map window and a Browser window, the objects
and the records are highlighted.

In all cases, a working table is automatically created called Selection. This table
contains the results of the query. You can map, or graph this table like any other
table. The table can also be saved as a separate table with Save Copy As.

B) General Procedure For Using SQL Select

The general procedure for using SQL Select is as follows:

1. Open the table you wish to query, if you haven't already done so.

The table that you query is known as the base table. If you use SQL Select to
perform a query on the World table, the World table is your base table.

2. Choose Query > SQL Select. Fill in the portions of the SQL Select dialog that
meet your needs. When you click OK, Maplnfo performs the query.

Maplnfo extracts data from your base table, stores the query results in a special,
temporary table, known as the results table. The results table contains only the rows
and columns that meet your criteria. The default name of the results table is Selection
(although you can specify a different results table name in the Into Table Named
field in the SQL Select dialog).

3. Open a Map window and/or a Browser window if you want to see the query
results. By default, MapInfo displays the results table in a Browser window
automatically (unless you clear the Browse Results checkbox in the SQL Select
dialog).
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If your results table is called Selection (the default name), the Browser window
shows a different table name, such as Queryl or Query2. This is because the moment
you Browse the Selection table, Maplnfo takes a "snapshot”" of the table, and names
the snapshot Queryn (where n is a number, one or greater). MapInfo takes the
snapshot because "Selection” is a special table name; Selection dynamically changes

every time you select or de-select rows.

In the SQL Select dialog, you can enter a different name for your results table (e.g.
you can name your results table My Query). This prevents MapInfo from renaming
your results table Queryn.

4. Maplnfo automatically selects all rows in the results table. Thus, after you
perform SQL Select, you can perform operations on the entire set of selected rows.
For example, you could apply a different fill color to all selected rows (by choosing
Options > Region Style), or you could cut or copy all selected rows.

Usually, any alterations you make to the results table are automatically applied to
your original (base) table. For example, if you use SQL Select to select some of the
rows from the Orders table, and then you delete some of the rows from your results
table, MapInfo deletes the corresponding rows from your base table (Orders).
However, if your query produces subtotals, you can alter the results table without
affecting the base table.

5. Choose File > Save As if you want to make a permanent copy of the results

table. If you do not perform Save As, the results table will be deleted when you exit
Maplnfo.

92



GEOGRAPHICAL QUERY MODULE OF TRANSFORMERS

Include "icons.def"
Include "menu.def"
Include "mapbasic.def"

Declare sub main
Declare sub tektr
Declare sub ozeltr
Declare sub ch tektr
Declare sub ch ozeltr
Declare sub Hakkinda
Declare sub exitmenu

Global k,wid as integer

Global t_name as string

Dim

ilcekom(10), adreskom(),mahalkom(), tradimahb (), tradimaho (), tradib(),t
radio(),teastip() as string

Dim p,l as smallint

SUB MAIN
create menu "TRAFO ARAMA" as

"Tedas' a Ait"™ calling "tektr",
"Ozel Trafolar" calling "ozeltr",
" (_",
"Cik" calling exitmenu

Alter Menu Bar Add "TRAFO ARAMA"

end sub

SUB tektr
select ilce adi from ilce where ilce _adi <> "" group by ilce_ adi
order by ilce adi into toplam ilce
k=1
do while not EOT (toplam ilce)
ilcekom(k)=toplam ilce.ilce_ adi
FETCH NEXT FROM toplam ilce
k=k+1
loop

select * from trafolar where Kimin="TEDAS" and ilceadi= ilcekom (1)
order by mahalleadi,trafoadi into selt
redim adreskom(tableinfo("selt"”,tab info nrows))
redim mahalkom(tableinfo("selt"”,tab info nrows))
k=1
FETCH FIRST FROM SELt
do while not EOT (selt)
mahalkom(k)=selt.trafoadi+" - "+selt.mahalleadi
adreskom(k)=selt.trafoadi
FETCH NEXT FROM selt
k=k+1
loop
dialog Title "TEDAS TRAFOLARI"
control statictext position 10,10 title "Ilge adi :"
control Popupmenu title FROM VARIABLE ilcekom value 1 id 1 calling
CH_tektr position 10,20
control statictext position 90,10 title "Trafo Adi :"
control listbox title from variable mahalkom height 90 value 1 id 2
into p position 90,20 width 120
control OKbutton title "Ara” position 50,120 id 5
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control cancelbutton title "iptal” position 110,120
If CommandInfo(CMD INFO DLG OK) Then
select * from selt where trafoadi=adreskom(p) into sell
set map zoom 750 units "m"
run menu command 306
end if
END SUB

SUB CH_tektr
select * from trafolar where Kimin="TEDAS" into tektr
select * from tektr where ilceadi=ilcekom(readcontrolvalue(l)) order
by mahalleadi,trafoadi into selt
select * from selt where trafoadi <> "" into sell
if tableinfo("sell",tab _info_nrows) =0 then
redim mahalkom (1)
mahalkom(1l)="bu tipte trafo bulunamadi "
alter control 2 disable
alter control 5 hide
alter control 2 title from variable mahalkom
else
redim adreskom(tableinfo("selt",tab info nrows))
redim mahalkom(tableinfo("selt"”,tab info_nrows))
alter control 2 enable
alter control 5 show

k=1
do while not EOT (selt)
mahalkom(k)=selt.trafoadi+" - "+selt.mahalleadi
adreskom(k)=selt.trafoadi
FETCH NEXT FROM selt
k=k+1
loop
alter control 2 title from variable mahalkom
end if
END SUB
b e e e N o S .. P _ (S | . o o — A ., o, Y
SUB ozeltr

select ilce_adi from ilce where ilce_adi <> "" group by ilce_adi
order by ilce adi into toplam ilce
k=1

do while not EOT (toplam ilce)

ilcekom(k)=toplam ilce.ilce adi

FETCH NEXT FROM toplam ilce

k=k+1

loop

select * from trafolar where Kimin="0ZEL" and ilceadi= ilcekom(1l)
order by mahalleadi, trafoadi into selo
redim adreskom(tableinfo("selo",tab info nrows))
redim mahalkom(tableinfo("selo",tab_info nrows))
k=1
FETCH FIRST FROM SELo
do while not EOT (selo)
mahalkom(k)=selo.trafoadi+" - "+selo.mahalleadi
adreskom (k) =selo.trafoadi
FETCH NEXT FROM selo
k=k+1
loop
dialog Title "OZEL TRAFOLAR"
control statictext position 10,10 title "ilge adi: "
control Popupmenu title FROM VARIABLE ilcekom value 1 id 1 calling
CH ozeltr position 10,20
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control statictext position 90,10 title "Trafo Adi: "
control listbox title from variable mahalkom height 90 value 1 id 2
into p position 90,20 width 120
control OKbutton title "Ara" position 50,120 id 5
control cancelbutton title "iptal"” position 110,120
If CommandInfo (CMD INFO_DLG OK) Then

select * from selo where trafoadi=adreskom({p) into sell
set map zoom 750 units "m"
run menu command 306
end if
END SUB

SUB CH ozeltr !
select * from trafolar where Kimin="OZEL" into ozeltr
select * from ozeltr where ilceadi=ilcekom(readcontrolvalue(l))
order by mahalleadi,trafoadi into selo
select * from selo where trafoadi <> "" into sell
if tableinfo("sell",tab info nrows) =0 then
redim mahalkom(1)
mahalkom(1l)="bu tipte trafo bulunamadi "
alter control 2 disable
alter control 5 hide
alter control 2 title from variable mahalkom
else
redim adreskom(tableinfo("selo",tab info nrows))
redim mahalkom(tableinfo("selo",tab_info nrows))
alter control 2 enable
alter control 5 show

k=1
do while not EOT (selo)
mahalkom(k)=selo.trafoadi+" - "+selo.mahalleadi
adreskom(k)=selo.trafoadi
FETCH NEXT FROM selo .
k=k+1
loop

alter control 2 title from variable mahalkom

end if

END SUB

SUB EXITMENU
End program
END SUB
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APPENDIX IV

Running A MapBasic Program

Use Run in the Tools menu to run a MapBasic program. MapBasic is a programming
language that you can use to customize or automate Maplnfo. To create MapBasic
applications, you need the MapBasic compiler, which is a separate product. However,
you do not need the MapBasic compiler to run a completed MapBasic application.
Maplnfo comes with an assortment of completed MapBasic applications. Some

examples include:

Symbol application (symbol.mbx). Create custom symbol shapes.

Scale Bar application (scalebar.mbx). Annotate a map with a distance scale.

Named Views application (nviews.mbx). Assign a name to the current map view and
use that name to return to that view later.

Overview application (overview.mbx). Open a second Map window that displays an

overview of the current map (also referred to as an area detail map).

To run a MapBasic application:

1. Choose File > Run MapBasic Program. The Run MapBasic Program dialog
displays.

2. Choose a directory.

3. Choose an application from the list (MapBasic applications have an .mbx
extension).

4. Click OK.

Maplnfo then runs the MapBasic application.
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Issuing Commands Through The MapBasic Window

When you issue a command through the MapBasic window, you must use the correct
syntax. When you choose many of MaplInfo's menu options, MapInfo displays the
commands in the MapBasic window. You can learn something about the syntax of
MapInfo commands simply by observing them in the window.

To issue a command through the MapBasic window:

1. Choose Options > Show/Hide MapBasic. The MapBasic Window displays.

2. Type the command.

3. Press Enter and Maplnfo executes the command.

When the command does not have the result you want, you can edit the command

statement by deleting items, adding new items, or rearranging items.

To reissue a command that you have previously issued:

1. Position the cursor anywhere within the command statement.

2. Press Enter.

This is particularly useful when you want to issue a command several times with

small changes each time.

To reissue a series of commands:

1. Choose the series by dragging the cursor over them to highlight them.

2. Press Enter.

To integrate the computer program written in MapBasic the subroutine should be

designed in the computer program.
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MODULE OF “MAINTENANCE PLANNING OF TRANSFORMERS”

Include "Mapbasic.def”
Include "Icons.def"™

Declare sub main

Declare sub bldg

Declare sub endprog

Declare sub building
Declare sub kapi

'Declare sub yenikayit
Global kayitnox() as string
Dim
degismenedenix(),degisikliktarihix(),markasix(),serinox(),imalyilix ()
as string

Dim gucux() as integer
Global tt as integer

SUB MAIN
create buttonpad "TBsss" as
toolbutton calling building
icon MI_ICON REALESTATE 1

id 1991
END SUB
T e ca cn VN oy s e e o o N—— | | SO | _ Sy g -
SUB BLDG
run menu command id 1991
END SUB

SUB BUILDING

dim %,y as float

dim i, k,ss,kno as integer
dim trafolar var as logical
dim

trafoadix, ilceadix, kodux, rrrl, rrrlx, rrr2, rrr2x, ppp, ppPpx, vvv, vvvx, kkk
, kkkx as string

dim ggg,gggx as integer
trafolar_ var=0
x=commandinfo (cmd info x)
y=commandinfo (cmd info y)

i=searchpoint (frontwindow (), x,y)
for k=1 to i
if searchinfo(k,1l)="trafolar" then
ss=searchinfo(k, search_info_row)
select * from trafolar where rowid=ss into secilen_ trafo
trafolar_var=l
end if
next
if trafolar var then

kodux=secilen trafo.kodu
trafoadix=secilen trafo.trafoadi
ilceadix=secilen trafo.ilceadi

select * from trafobilgileri where kodu=kodux into secilen_trafo

if selectioninfo(sel info nrows) then
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redim kayitnox(selectioninfo(sel info nrows))
redim degismenedenix(selectioninfo(sel_info nrows))
redim degisikliktarihix(selectioninfo(sel info_ nrows))
redim markasix(selectioninfo(sel info_nrows))
redim serinox(selectioninfo(sel info nrows))
redim imalyilix(selectioninfo(sel_info_nrows))
redim gucux(selectioninfo({sel info nrows))

fetch first from secilen_trafo
k=1
do while not eot(secilen_trafo)
kayitnox (k)=secilen trafo.kayitno
degismenedenix(k)=secilen_trafo.degisme nedeni
degisikliktarihix(k)=secilen trafo.degisiklik tarihi
gucux (k)=secilen_trafo.gucu
markasix(k)=secilen trafo.markasi
serinox (k)=secilen trafo.serino

imalyilix(k)=secilen_trafo.imal yili
k=k+1
fetch next from secilen trafo
loop
vvv=degismenedenix (1)
ppp=degisikliktarihix (1)
ggg=gucux (1)
rrrl=markasix(1l)
rrr2=serinox (1)
kkk=imalyilix (1)
else k=1
end if
dialog title "TRAFO BILGISI"™ POSITION 10,10
control groupbox position 5,5 title "TRAFO ADRES BILGILERI"
width 200 height 81

control statictext position 10,20 title "ILGCESI :"
control statictext position 60,20 title ilceadix

control statictext position 10,45 title "TRAFO ADI :"
control statictext position 60,45 title trafoadix
control statictext position 10,65 title "TRAFO Kodu :"
control statictext position 60,65 title kodux

control groupbox position 5,91 title "Trafo-Detay Bilgisi"
width 200 height 145

control statictext position 15,107 title "Kayit No :"

control statictext position 15,122 title "Degisme Nedeni :"

control statictext position 15,137 title "Degisme Tarihi :"

control statictext position 15,152 title "Gucu :"

control statictext position 15,167 title "Markasi :"
control statictext position 15,182 title "Serino :"
control statictext position 15,197 title "Imal Yili :"

control popupmenu position 75,107 title from variable Kayitnox

calling kapi id 1 value 1 width 30

control edittext position 75,122 value vvv id 2 width 120 into

vvvx 'Degisme Nedeni

control edittext position 75,137 value ppp id 3 width 120 into

Pppx 'Degisiklik Tarihi

control edittext position 75,152 value ggg id 3 width 120 into

gggx 'Gucu
control edittext position 75,167 value rrrl id 4 width 120
into rrrix 'Markasi
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control edittext position 75,182 value rrr2 id 5 width 120
into rrr2x ‘Serino

control edittext position 75,197 value kkk id 6 width 120 into
kkkx 'Imal yili

control okbutton title "Kaydet" position 55,215
control cancelbutton title "Iptal"™ position 120,215

if commandinfo(cmd_info_dlg_ok) then

Insert Into trafobilgileri

{kayitno, trafoadi, kodu, ilceadi,degisiklik tarihi,degisme nedeni, gucu
;serino,markasi,imal yili) values

(k,trafoadix, kodux, ilceadix, pppx, vvvx, gggx, rrr2x, rrrlx, kkkx)

end if
end if
exit sub
END SUB
¥ e e
SUB KAPIL

Dim sl as integer

Dim vvv,ppp,rrrl,rrr2,kkk as string
dim ggg as integer
sl=readcontrolvalue(l)
vvv=degismenedenix (sl)

ggg=gucux (sl)
ppp=degisikliktarihix (sl)
rrrl=markasix(sl)

rrr2=serinox(sl)

kkk=imalyilix{sl)

alter control 2 value vvv
alter control 3 value ppp
alter control 4 value rrrl
alter control 5 value rrr2
alter control 6 value kkk
END SUB

T e e e et e e e e e e e e et T e Y o P T = — — " 2 o ———
SUB ENDPROG

end program

END SUB

P e e e ——— *
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